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How This Manual Is Organized

� Notice

To view the manuals in PDF format, Adobe Reader/Adobe Acrobat Reader is 
required. If Adobe Reader/Adobe Acrobat Reader is not installed on your 
system, please download it from the Adobe Systems Incorporated website.

Before You Start

Setting Up the Network Environment for Printing

Managing the Printer in the Network Environment

Troubleshooting

Appendix

A list of the network setting items, specifications of the network board, index, and 
others are provided.

Chapter 1

Chapter 2

Chapter 3

Chapter 4

Chapter 5
Considerable effort has been made to ensure that this manual is free of inaccuracies and omissions. However, as we are constantly improving our 
products, if you need an exact specification, please contact Canon.
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Preface
Thank you for purchasing this Canon product. 
Please read this manual thoroughly before operating the printer in order to familiarize 
yourself with its capabilities, and to make the most of its many functions. 
After reading this manual, store it in a safe place for future reference.

How To Use This Manual

Symbols Used in This Manual
The following symbols are used in this manual to indicate operational requirements 
or clarification.

IMPORTANT Indicates operational requirements and restrictions. 
Be sure to read these items carefully in order to operate the printer 
correctly, and to avoid damage to the printer.

NOTE Indicates a clarification of an operation, or contains additional 
explanations for a procedure. 
Reading these notes is highly recommended.

Buttons Used in This Manual
The following button names are a few examples of how buttons to be pressed are 
expressed in this manual:

• Buttons on Computer Operation Screen: [Button Name]
Example: [OK]

[Details]
v



                                  
Displays Used in This Manual
Displays used in this manual may differ from those on your computer depending on 
the system environment.

The buttons which you should press are marked with a  as shown below.

When multiple buttons can be pressed on the screen shot of computer operation 
screen, all buttons are marked. Select the button which suits your needs.

Abbreviations Used in This Manual
In this manual, product names and model names are abbreviated as follows:

Microsoft® Windows® 98 operating system: Windows 98

Microsoft® Windows® Millennium Edition operating system: Windows Me

Microsoft® Windows NT® operating system: Windows NT

Microsoft® Windows® 2000 operating system: Windows 2000

Microsoft® Windows® XP operating system: Windows XP

Microsoft® Windows ServerTM 2003 operating system: Windows Server 2003

Microsoft® Windows® operating system: Windows

7 Click [Next].

Click this button for operation.
vi



      
Legal Notices
Trademarks
Canon, the Canon logo, LBP, and NetSpot are trademarks of Canon Inc.

Adobe, Adobe Acrobat, and Adobe Reader are trademarks of Adobe Systems 
Incorporated.

Apple and Macintosh are trademarks of Apple Computer, Inc.

IBM and PowerPC are trademarks of International Business Machines Corporation.

Microsoft, MS-DOS, Windows, and Windows NT are registered trademarks of 
Microsoft Corporation in the United States and other countries.

Windows Server is a trademark of Microsoft Corporation.

Sun, Java, and Sun Microsystems are trademarks of Sun Microsystems, Inc. in the 
United States and other countries.

Ethernet is a trademark of Xerox Corporation.

Other product and company names herein may be the trademarks of their 
respective owners.

Copyright
Copyright 2005 by Canon Inc. All rights reserved.

No part of this publication may be reproduced or transmitted in any form or by any 
means, electronic or mechanical, including photocopying and recording, or by any 
information storage or retrieval system without the prior written permission of 
Canon Inc.
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Disclaimers
The information in this manual is subject to change without notice.

CANON INC. MAKES NO WARRANTY OF ANY KIND WITH REGARD TO THIS 
MATERIAL, EITHER EXPRESS OR IMPLIED, EXCEPT AS PROVIDED HEREIN, 
INCLUDING WITHOUT LIMITATION, THEREOF, WARRANTIES AS TO 
MARKETABILITY, MERCHANTABILITY, FITNESS FOR A PARTICULAR 
PURPOSE OF USE OR AGAINST INFRINGEMENT OF ANY PATENT. CANON 
INC. SHALL NOT BE LIABLE FOR ANY DIRECT, INCIDENTAL, OR 
CONSEQUENTIAL DAMAGES OF ANY NATURE, OR LOSSES OR EXPENSES 
RESULTING FROM THE USE OF THIS MATERIAL.
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CHAPTER

1
Before You Start
This chapter describes a brief overview of the requisite tasks to perform and the system 
environment of the software for printing or managing the printing operation in a network 
environment.

Requisite Tasks Before Printing or Managing the Printing Operation . . . . . . . . . . . . . . . .1-2
Configuring the Printer to Print in a Network Environment . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .1-2

Managing the Printer in the Network Environment . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .1-4

System Requirements  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .1-5
Printer Driver. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .1-5

Print Monitor Installer (Canon CAPT Print Monitor)  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .1-5

Remote UI. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .1-6

NetSpot Device Installer. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .1-7
1-1
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Requisite Tasks Before Printing or Managing the Printing 
Operation
Configuring the Printer to Print in a Network Environment
The following shows the tasks that should be performed after installing the printer 
and optional network board.

NOTE
For details on the procedure for installing the network board, see "User's Guide".

� Installing the Printer Driver
* There are two ways to install the printer driver.

The procedures for setting the IP address or creating a port vary depending on the installation method.

<Setting Up 
Automatically>

<Setting Up Manually>

Installing from 
CD-ROM Setup (See 

p. 2-2)
∗ You can set the IP 

address, create a 
port, and install the 
printer driver at once.

IP Address Setting

IP Address Setting 
Using NetSpot 

Device Installer (See 
p. 2-15)

IP Address Setting 
Using the ARP/PING 

Command (See p. 
2-22)

* If you are using 
Windows XP Service 
Pack 2 or another 
operating system 
equipped with 
Windows Firewall, set 
the IP address using 
the ARP/PING 
command.

IP Address Setting 
Using the Printer 

Status Window (See 
p. 2-24)

* You can set the IP 
address from the 
Printer Status 
Window if the printer 
driver has already 
been installed by the 
USB connection.

Creating a Port

Installing Canon CAPT Print Monitor Using Print Monitor 
Installer (See p. 2-26)

Installing the Printer Driver

Installing the Printer Driver from [Add Printer Wizard] (See 
p. 2-31)
1-2 Requisite Tasks Before Printing or Managing the Printing Operation
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� Performing the Protocol Settings for the Printer
* Specify the protocol settings as needed.

There are three kinds of methods to perform the protocol settings, and the specifiable options vary depending on 
the application.

Installing the Printer Driver
The printer driver is software required for printing from an application you use. 
There are the following two ways to install the printer driver. The procedures for 
setting the IP address or creating a port (Canon CAPT Port) required to print in a 
network environment vary depending on the installation method.

� Installing the CAPT Software from CD-ROM Setup (See p. 2-2)
If you install the printer driver from the supplied CD-ROM (CD-ROM Setup), you can 
easily configure the printer to print in a network environment by setting the IP address and 
creating a port at once.

� Installing the Printer Driver Manually Using Various Utility Software (See p. 
2-14)
Specify the IP address or create a port using the software in the supplied CD-ROM 
("NetSpot Device Installer" or "Print Monitor Installer"), the ARP/PING command or 
others, and then install the printer driver from [Add Printer Wizard].

Performing the Protocol Settings for the Printer
After installing the printer driver, perform the protocol settings for the printer as 
needed. You can perform the protocol settings from the computer you are using, 
using any one of the following software.

� Protocol Settings Using the Remote UI (See p. 2-60)
Perform the protocol settings by accessing the printer from your web browser via the 
network. 

� Protocol Settings Using NetSpot Device Installer (See p. 2-70)
Perform the basic protocol settings by starting NetSpot Device Installer from the supplied 
CD-ROM. When configuring the DNS server etc., use the Remote UI or FTP Client.

� Protocol Settings Using FTP Client (See p. 2-74)
Perform the protocol settings by accessing the FTP server in the network board using 
Command Prompt (MS-DOS Prompt for Windows 98/Me).

Protocol Settings

Protocol Settings 
Using the Remote 
UI (See p. 2-60)

Protocol Settings 
Using NetSpot 
Device Installer 
(See p. 2-70)

Protocol Settings 
Using FTP Client 

(See p. 2-74)
1-3Requisite Tasks Before Printing or Managing the Printing Operation
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Managing the Printer in the Network Environment
You can perform the printer management, such as checking the printer status and 
specifying various settings, in a network environment using the following software. 
The specifiable options vary depending on the software. See "Network Setting 
Items" (p. 5-2), and use software appropriate to the network environment you are 
using or options that you want to specify.

� Remote UI (See p. 3-3)
The Remote UI is software that allows you to manage the printer using a web browser. By 
accessing the printer from the web browser via a network, you can check the printer 
status or job history, and configure the network or security settings.

� NetSpot Device Installer (See p. 3-45)
NetSpot Device Installer is software included on the supplied CD-ROM. Without installing 
it, you can run NetSpot Device Installer from the supplied CD-ROM and specify the 
settings for the protocols or device information.

� FTP Client (See p. 3-42)
FTP Client allows you to specify the settings for various information about the device and 
configure the network and security by accessing the FTP server on the network board 
using Command Prompt (MS-DOS Prompt for Windows 98/Me).

� NetSpot Console (See Online Manual)
NetSpot Console is software that allows you to manage the printers connected on a 
network using the web browser that you have. NetSpot Console allows you to view a list of 
printers, display a printer map, and view a variety of printer information.

IMPORTANT
When using NetSpot Console, it needs to be installed on any one of the computers on 
the network. If NetSpot Console is installed on none of the computers, install it on any of 
the computers. For details on the installation procedure, see Readme of NetSpot 
Console. For more details on the setting procedure, see the online manual of NetSpot 
Console.

NOTE
Install NetSpot Console by downloading it from the Canon website.
1-4 Requisite Tasks Before Printing or Managing the Printing Operation
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Printer Driver
The following system environment is required to use the printer driver:

� Operating system software
• Microsoft Windows 98
• Microsoft Windows Me
• Microsoft Windows 2000 Server/Professional
• Microsoft Windows XP Professional/Home Edition*
• Microsoft Windows Server 2003*
* 32-bit processor version only

IMPORTANT
For details on the minimum-required and recommended system requirements, see 
"User's Guide".

� Interface
• Connector: 10BASE-T or 100BASE-TX
• Protocol: TCP/IP

NOTE
• When using Sound, a PC synthesizer (and the driver for PCM synthesizer) must be 

installed in your computer. Do not use a PC Speaker driver (speaker.drv etc.).
• Installation of the printer driver on a Macintosh computer and printing operation from a 

Macintosh computer via a network are not supported.

Print Monitor Installer (Canon CAPT Print Monitor)
The following system environment is required to use Print Monitor Installer (Canon 
CAPT Print Monitor).

� Operating system software
• Microsoft Windows 98
• Microsoft Windows Me
• Microsoft Windows 2000 Server/Professional
• Microsoft Windows XP Professional/Home Edition*
• Microsoft Windows Server 2003*
* 32-bit processor version only
1-5System Requirements
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- System Requirements (minimum required)

(PC/AT Compatibles)

* As the amount of available memory varies depending on the system configuration of the computer or application 
you are using, the above environment does not guarantee printing in all cases.

- System Requirements (recommended)

� Protocol
• TCP/IP

Remote UI
The following system environment is required to use the Remote UI:

� Web Browser
• Netscape Navigator 4.7 or later
• Internet Explorer 4.01SP1 or later

� Operating System
• An operating system on which the above web browser can run

� Display
• Resolution: 800 x 600 pixels or more
• Display colors: 256 or more

NOTE
Software other than the above one, such as a web server, is not required. (A web server 
is preinstalled in the printer.)

Windows 98/Me Windows 2000/XP/Server 2003

CPU
Pentium II
300 MHz or more

Pentium II
300 MHz or more

Memory (RAM)* 64 MB or more 128 MB or more

Hard Disk 20 MB or more 20 MB or more

Windows 98/Me Windows 2000/XP/Server 2003

CPU
Pentium III
600 MHz or more

Pentium III
600 MHz or more

Memory (RAM) 128 MB or more 256 MB or more
1-6 System Requirements
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NetSpot Device Installer
The following system environment is required to use NetSpot Device Installer:

� Operating system software
• Microsoft Windows 98 + Service Pack 1 or later
• Microsoft Windows 98 Second Edition
• Microsoft Windows Me
• Microsoft Windows NT Server/Workstation 4.0 + Service Pack 4 or later*
• Microsoft Windows 2000 Server/Professional
• Microsoft Windows XP Professional/Home Edition
• Windows Server 2003
* You can configure the network settings, but you cannot print.

� Computer
• A computer in which the above operating system can run

� Hard Disk
• Free disk space of 15 MB or more (When the software is to be installed on the computer)

� Protocol
• TCP/IP

� Protocol Stack
• The TCP/IP protocol supplied with Windows
1-7System Requirements
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2
Setting Up the Network 
Environment for Printing
This chapter describes the procedures for printing in a network environment.
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Installing the CAPT Software
Install the printer driver on the computer you are using. The printer driver is 
software required for printing from an application you use. There are the following 
two ways to install the printer driver. The procedures for setting the IP address or 
creating a port (Canon CAPT Port) required to print in a network environment vary 
depending on the installation method.

� Installing the CAPT Software from CD-ROM Setup (See p. 2-2)
If you install the printer driver from the supplied CD-ROM (CD-ROM Setup), you can 
configure the printer to print in a network environment by setting the IP address and 
creating a port at once.

� Installing the Printer Driver Manually Using Various Utility Software (See p. 
2-14)
Specify the IP address or create a port using the software in the supplied CD-ROM 
("NetSpot Device Installer" or "Print Monitor Installer"), the ARP/PING command or 
others, and then install the printer driver from [Add Printer Wizard].

IMPORTANT
The printer driver is required for printing with this printer. Be sure to install the printer 
driver.

NOTE
For procedures for installing the CAPT software by connecting the printer and computer 
with a USB cable or by sharing the printer on a network, see "User's Guide".

Installing the CAPT Software from CD-ROM Setup
This section describes the procedure for installing the printer driver from the 
supplied CD-ROM (CD-ROM Setup). If you install the printer driver from the 
supplied CD-ROM, you can configure the printer to print in a network environment 
by setting the IP address and creating a port at once.

IMPORTANT
When there is not enough free hard disk space, a message will appear during the 
installation. Stop the installation and increase the free space, and then install the CAPT 
software again.

NOTE
The screen shots used in this section are from Windows XP Professional.
2-2 Installing the CAPT Software
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1 Make sure that the computer and printer are connected via the 
network and that the printer is ON.

2 Turn the computer on and start up Windows.

NOTE
If you are using Windows 2000/XP/Server 2003, be sure to log on as a member of 
Administrators when starting up.

3 Insert the supplied CD-ROM into the CD-ROM drive.

If the CD-ROM is already in the drive, eject the disk and re-insert it into the drive.

IMPORTANT
If CD-ROM Setup does not appear, select [Run] from the [Start] menu, enter 
"D:\English\MInst.exe", and then click [OK]. (The CD-ROM drive name is indicated 
as "D:" in this manual. The CD-ROM drive name may differ depending on the 
computer you are using.)

4 Click [Easy Installation] or [Custom Installation].

[Easy Installation] allows you to install the printer driver and the instruction 
manuals simultaneously. If you do not install the manuals, select [Custom 
Installation].
2-3Installing the CAPT Software
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5 Click [Install].

If you selected [Custom Installation] in Step 4, clear the [Online Manuals] check 
box, and then click [Install].

6 Click [Next].
Installing the CAPT Software2-4
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7 Confirm the contents and select [I accept the terms in the 
license agreement], and then click [Next].

8 Select [Search for Network Port to Install], then click [Next].

9 Click [Add/Delete].
2-5Installing the CAPT Software
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The TCP/IP port on the network is searched, and the printer is detected 
automatically.

If you are using Windows XP Service Pack 2 or another operating system 
equipped with Windows Firewall, and the Windows Firewall is enabled, the 
following screen is displayed.

If the IP address of the printer has been already set, click [No].
If you want to clear the block and detect the printers in which the IP address has 
not been set yet, click [Yes].

NOTE
If you want to specify the IP address in advance, cancel the installation, and see 
"Installing the Printer Driver Manually Using Various Utility Software" (p. 2-14) to 
specify the IP address.

10 Select the printer to be installed from [Printer List], then click 
[Add to the Printer List for Driver Installation].

NOTE
If the printer to be installed is not displayed in [Printer List], make sure that the 
computer and printer are connected via the network and that the printer is ON.

� When the name of this printer is displayed in [Device Name]

❑ Select the printer to be installed, then click [Add to the Printer List for Driver 
Installation].
Installing the CAPT Software2-6
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NOTE
Depending on the system environment, "192.168.0.215" (the default value for the 
network board) is displayed in [IP Address] under [Printer List]. If you want to 
change the IP address, see "Protocol Settings for the Printer" (p. 2-60) to change 
the IP address after finishing the installation.

� When [Unknown Device] is displayed in [Device Name]

❑ Select the printer displayed as [Unknown Device], then click [Set IP Address].

NOTE
If more than one [Unknown Device] are displayed, select the MAC address of the 
printer to be installed. The MAC address is indicated on the reverse side of the 
network board (A) as shown in the following figure.

❑ Enter the IP address of the printer in the [Set IP Address] dialog box, then click 
[OK].

ERR LNK 100

NB-C1

(A)
2-7Installing the CAPT Software
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[Get automatically]: Obtain an IP address using DHCP (The DHCP server 
needs to be started up). For more details on configuring the DHCP server, ask 
your network administrator.
[Use the following IP address]: Specify the IP address directly (Enter the IP 
address by separating the numbers with a period (.), for example, 
AAA.BBB.C.DD).

NOTE
If the printer to be installed is not displayed in [Printer List], perform the following 
settings:
- Click [Update Printer List]. The printers on the network are searched for again.
- Click [Search by IP Address]. By entering the IP address of the printer to be 

installed in the displayed [Search by IP Address] dialog box and clicking [OK], the 
printer that has the entered IP address is searched for (Enter the IP address by 
separating the numbers with a period (.), for example, AAA.BBB.C.DD).

11 Click [OK].

If you are using Windows XP Service Pack 2 or another operating system 
equipped with Windows Firewall, and the Windows Firewall is enabled, click 
[Yes] when the following screen is displayed.

A port (Canon CAPT Port) is created automatically.
Installing the CAPT Software2-8
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12 Make sure that the name of this printer is added to [Printer 
List for Driver Installation].

� When you do not specify the settings for the printer information 
such as the printer sharing settings

❑ Click [Next].

� When you specify the settings for the printer information such as 
the printer sharing settings

❑ Select the [Set Printer Information] check box, then click [Next].
2-9Installing the CAPT Software
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❑ Specify the settings for the printer information.

Options to be specified

❑ If you have selected the [Use as Shared Printer] check box, click [Details], and 
then specify the detailed settings for the shared printer. Change the share 
name as needed. If there is any computer on which Windows 98/Me runs on 
the network, select [Intel Windows 98/Me], then click [OK].

[Printer Name]: Enter a new name in [Printer Name] if you want to 
change the printer name.

[Use as Shared Printer]: When the computer on which you are currently installing 
the printer driver is to be used as a print server, select 
the [Use as Shared Printer] check box.

[Set as Default]: When using this printer as the default printer, select the 
[Set as Default] check box.
Installing the CAPT Software2-10
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❑ Click [Next].

13 Click [Start].

If you are using Windows XP Service Pack 2 or another operating system 
equipped with Windows Firewall, the following screen is displayed. Specify 
whether to configure Windows Firewall to unblock communication with the client 
computers when sharing the printer on a network.
Click [Yes] when you share the printer on the network.
Click [No] when you do not share the printer on the network.

NOTE
Even after the installation, you can change the Firewall settings using "CAPT 
Windows Firewall Utility" in the supplied CD-ROM. For more details, see "User's 
Guide".
2-11Installing the CAPT Software



S
et

tin
g 

U
p 

th
e 

N
et

w
or

k 
E

nv
iro

nm
en

t f
or

 P
rin

tin
g

2

14 The message <Installation cannot be stopped once it starts. 
Do you want to continue?> appears. Click [Yes].

Installation of the printer driver starts.

NOTE
• If you are using Windows 2000 and the [Digital Signature Not Found] dialog box 

appears, click [Yes].
• If you are using Windows XP/Server 2003 and the [Hardware Installation] dialog 

box appears, click [Continue Anyway].

15 The screen that informs you of the completion of the printer 
driver installation is displayed. Click [Exit].

16 If [Easy Installation] is selected in Step 4, the manuals are 
installed.
Installing the CAPT Software2-12
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17 Confirm the installation results, then click [Next].

NOTE
If the printer driver is not installed properly, see "Installation Problems," on p. 4-2.

18 Select the [Restart Computer Now (Recommended)] check 
box, then click [Restart].

Windows restarts.

The installation of the printer driver is completed. If you want to configure the protocol 
settings, see "Protocol Settings for the Printer," on p. 2-60.
2-13Installing the CAPT Software
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Installing the Printer Driver Manually Using Various Utility 
Software

This section describes the procedures for installing the printer driver manually 
using various utility software. Before installing the printer driver from [Add Printer 
Wizard], you need to set the IP address and create a port (Canon CAPT Port) in 
order to configure the environment in which the printer and computer you are using 
can correspond to each other as shown in the following figure. Install the printer 
driver after configuring the network environment, following the procedure described 
in the figure.

IP Address Setting

IP Address Setting Using 
NetSpot Device Installer 

(See p. 2-15)

IP Address Setting 
Using the ARP/PING 

Command (See p. 2-22)

* If you are using Windows 
XP Service Pack 2 or 
another operating 
system equipped with 
Windows Firewall, set 
the IP address using the 
ARP/PING command.

IP Address Setting Using 
the Printer Status Window 

(See p. 2-24)

* You can set the IP address 
from the Printer Status 
Window if the printer driver 
has already been installed 
by the USB connection.

Creating a Port

Installing Canon CAPT Print Monitor Using Print Monitor 
Installer (See p. 2-26)

Installing the Printer Driver

Installing the Printer Driver from [Add Printer Wizard] (See 
p. 2-31)
Installing the CAPT Software2-14
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NOTE
The MAC address is required to set the IP address using the ARP/PING command. The 
MAC address is indicated on the reverse side of the network board (A) as shown in the 
following figure.

IP Address Setting Using NetSpot Device Installer

IMPORTANT
• If you are using Windows XP Service Pack 2 or another operating system equipped with 

Windows Firewall, and the Windows Firewall is enabled, it is recommended that you set 
the IP address using the ARP/PING command. For details on the procedure for setting 
the IP address using the ARP/PING command, see "IP Address Setting Using the ARP/
PING Command," on p. 2-22.

• If you are using Windows XP Service Pack 2 or another operating system equipped with 
Windows Firewall and the Windows Firewall is enabled, and when you set the IP address 
using NetSpot Device Installer, perform either of the following procedures.
- Add "NetSpot Device Installer" to the [Exceptions] sheet in the [Windows Firewall] 

dialog box (See Readme of NetSpot Device Installer)
- Installing NetSpot Device Installer (See p. 3-46)

NOTE
• The screen shots used in this section are from Windows XP Professional.
• This section describes the procedure for using NetSpot Device Installer without installing 

it. For details on the procedures for installing NetSpot Device Installer, see "Managing the 
Printer Using NetSpot Device Installer," on p. 3-45.

ERR LNK 100

NB-C1

(A)
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1 Make sure that the computer and printer are connected via the 
network and that the printer is ON.

2 Insert the supplied CD-ROM into the CD-ROM drive.

3 Click [Additional Software Programs].

4 Click [Start] in [NetSpot Device Installer for TCP/IP].

5 Set the IP address.

Display screens of NetSpot Device Installer vary depending on the system 
environment.
Perform the following procedure according to the contents displayed in the 
device list.
Installing the CAPT Software2-16
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IMPORTANT
• If you are using Windows XP Service Pack 2 or another operating system equipped 

with Windows Firewall, and the Windows Firewall is enabled, the printer in which 
the IP address has not been set yet is not displayed. It is recommended that you 
set the IP address using the ARP/PING command. For details on the procedure for 
setting the IP address using the ARP/PING command, see "IP Address Setting 
Using the ARP/PING Command," on p. 2-22.

• If you are using Windows XP Service Pack 2 or another operating system equipped 
with Windows Firewall and the Windows Firewall is enabled, and when you set the 
IP address using NetSpot Device Installer, perform either of the following 
procedures.
- Add "NetSpot Device Installer" to the [Exceptions] sheet in the [Windows Firewall] 

dialog box (See Readme of NetSpot Device Installer)
- Installing NetSpot Device Installer (See p. 3-46)

NOTE
If you are using an operating system other than Windows XP Service Pack 2 or 
another operating system equipped with Windows Firewall, and the desired printer 
is not detected, select [Discover Devices] from the [View] menu, and then search 
for the printer again.

� When [Status] is set to [Not Configured], and the device of which 
[Device Name] is the MAC address on the network board is dis-
played on the device list

❑ Select the device.
2-17Installing the CAPT Software
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❑ Select [Initial Settings] from the [Device] menu.

NOTE
You can obtain the same result by right-clicking the selected device and selecting 
[Initial Settings] from the pop-up menu.

❑ Specify the following settings in the [Initial Settings] dialog box, then click 
[Next].

Options to be specified

[Subnet]: When the computer on which NetSpot Device Installer is 
running is connected to multiple networks (when multiple 
network interface boards are installed), select the subnet to 
which the device to be configured belongs.

[Product Type]:Select [LBP + NB-C1].
Installing the CAPT Software2-18
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❑ Specify the IP address.

Options to be specified

[IP Address Setting with]: Select the method for setting the IP address.

[Manual 
Setting]:

Allows you to specify the IP address 
directly. The IP address entered in 
[IP Address] is specified for the 
network board.

[DHCP]: Obtains an IP address using DHCP. 
(The DHCP server needs to be 
started up.)

[IP Address]: Enter the IP address of the network board.

Options to be specified as needed

[Subnet Mask]: Enter the subnet mask that is being used on the 
TCP/IP network.

[Gateway Address]: Enter the gateway address that is being used on 
the TCP/IP network.

[Broadcast Address]: Enter the broadcast address that is being used 
on the TCP/IP network.
2-19Installing the CAPT Software
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� When any device in which the setting for [IP Address] is the default 
setting is displayed in the device list

❑ Select the device.

❑ Select [Protocol Settings] from the [Device] menu.
Installing the CAPT Software2-20
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❑ Specify the IP address.

Options to be specified

Options to be specified as needed

NOTE
• If RARP, BOOTP, or DHCP is selected, you cannot enter any value in [IP Address].
• If you cannot use RARP, BOOTP, and DHCP, specify [Manual Setting].

[IP Address Setting with]: Select the method for setting the IP address.

[Manual 
Setting]:

Allows you to specify the IP address 
directly. The IP address entered for [IP 
Address] is specified for the network board.

[Auto Detect]: Obtains an IP address using RARP, 
BOOTP, or DHCP.

[RARP]: Obtains an IP address using RARP. (The 
RARP daemon needs to be started up.)

[BOOTP]: Obtains an IP address using BOOTP. (The 
BOOTP daemon needs to be started up.)

[DHCP]: Obtains an IP address using DHCP. (The 
DHCP server needs to be started up.)

[IP Address]: Enter the IP address of the network board.

[Subnet Mask]: Enter the subnet mask that is being used on the TCP/IP 
network.

[Gateway Address]: Enter the gateway address that is being used on the TCP/IP 
network.
2-21Installing the CAPT Software
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� When your case falls within neither of the above cases

❑ If the display of NetSpot Device Installer falls within neither of the above even if 
you are using an operating system other than Windows XP Service Pack 2 or 
another operating system equipped with Windows Firewall, the network cable 
is connected properly, and the printer is ON, there is a possibility that a device 
that has the same IP address as the default IP address of the printer exists on 
the network. In this case, turn off the device that has the same IP address or 
remove the device from the network, and then perform the procedure from 
Step 1 (See p. 2-16) again. After completing the settings for this printer, restore 
the devices to their original states. If this method is impossible, set the IP 
address using the ARP/PING command. For details on the procedure for 
setting the IP address using the ARP/PING command, see "IP Address Setting 
Using the ARP/PING Command," on p. 2-22.

6 After completing the settings, click [OK].

7 When the message <The device has been reset.> appears, 
click [OK].

After completing the reset, the settings are enabled.

Next, install the Canon CAPT Print Monitor. (See p. 2-26)

IP Address Setting Using the ARP/PING Command

1 Run Command Prompt or MS-DOS Prompt.

For Windows XP/Server 2003: From the [Start] menu, select [All Programs] � 
[Accessories] � [Command Prompt].
For Windows 2000: From the [Start] menu, select [Programs] � [Accessories] � 
[Command Prompt].
For Windows Me: From the [Start] menu, select [Programs] � [Accessories] � 
[MS-DOS Prompt].
For Windows 98: From the [Start] menu, select [Programs] � [MS-DOS Prompt].

2 Enter the following command, then press the [ENTER] key on 
your keyboard.

arp -s <IP Address> <MAC Address>
Installing the CAPT Software2-22
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NOTE
The MAC address is indicated on the reverse side of the network board (A) as 
shown in the following figure.

3 Enter the following command, then press the [ENTER] key on 
your keyboard.

The IP address is set on the network board.

NOTE
• l of "-l" is the letter "L" of the alphabet.
• The subnet mask and gateway address are set to [0.0.0.0].

4 Enter "exit", then press the [ENTER] key on your keyboard.

Exit Command Prompt or MS-DOS Prompt.

Next, install the Canon CAPT Print Monitor. (See p. 2-26)

IP Address: Specify the IP address to assign to the printer. Specify the address 
with four numbers (from 0 to 255) separated with a period (.).

MAC Address: Specify the MAC address of the printer. When entering the number, 
separate the number every two digits with a hyphen (-).

Input Example: arp  -s  192.168.0.215  00-00-85-05-70-31

ping <the IP Address> -l 479

IP Address: Specify the same IP address as the one used in Step 2.

Input Example: ping 192.168.0.215 -l 479

ERR LNK 100

NB-C1

(A)
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IP Address Setting Using the Printer Status Window
You can set the IP address from the Printer Status Window if the printer driver has 
already been installed by the USB connection.

NOTE
The screen shots used in this section are from Windows XP Professional.

1 Display the [Printers and Faxes] folder or the [Printers] folder.

For Windows 98/Me/2000: From the [Start] menu, select [Settings] � [Printers].
For Windows XP Professional/Server 2003: From the [Start] menu, select [Printers 
and Faxes].
For Windows XP Home Edition: From the [Start] menu, select [Control Panel], and 
then click [Printers and Other Hardware] � [Printers and Faxes].

2 Select the icon for this printer, then select [Printing 
Preferences] from the [File] menu.

For Windows 98/Me: Select the icon for this printer, then select [Properties] from 
the [File] menu.

3 Display the [Page Setup] sheet, then click [ ] (Display 
Printer Status Window) to run the Printer Status Window.

NOTE
For details on the Printer Status Window, see "User's Guide".
Installing the CAPT Software2-24
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4 From the [Options] menu, select [Device Settings] � [Network 
Settings].

5 Specify the IP address.

Options to be specified

[IP Address Setting with]: Select the method for setting the IP address.

[Manual 
Setting]:

Allows you to specify the IP address 
directly. The IP address entered for [IP 
Address] is specified for the network 
board.

[Auto 
Detect]:

Obtains an IP address using RARP, 
BOOTP, or DHCP.

[RARP]: Obtains an IP address using RARP. 
(The RARP daemon needs to be 
started up.)
2-25Installing the CAPT Software



S
et

tin
g 

U
p 

th
e 

N
et

w
or

k 
E

nv
iro

nm
en

t f
or

 P
rin

tin
g

2

NOTE
• If [RARP] is selected, you cannot enter any value in [IP Address].
• If [BOOTP] or [DHCP] is selected, you cannot enter any value in [IP Address], 

[Subnet Mask], and [Gateway Address].
• If you cannot use RARP, BOOTP, and DHCP, specify [Manual Setting].

6 After completing the settings, click [OK].

The Printer Status Window reappears.

Next, install Canon CAPT Print Monitor. (See p. 2-26)

Installing the Canon CAPT Print Monitor

NOTE
The screen shots used in this section are from Windows XP Professional.

1 Insert the supplied CD-ROM into the CD-ROM drive.

If CD-ROM Setup appears, click [Exit].

[BOOTP]: Obtains an IP address using BOOTP. 
(The BOOTP daemon needs to be 
started up.)

[DHCP]: Obtains an IP address using DHCP. 
(The DHCP server needs to be started 
up.)

[IP Address]: Enter the IP address of the network board.

Options to be specified as needed

[Subnet Mask]: Enter the subnet mask that is being used on the 
TCP/IP network.

[Gateway Address]: Enter the gateway address that is being used on 
the TCP/IP network.

[Password]: Enter the administrator password for the network 
board. If the password has not been specified yet, it 
is not required to enter the password.
Installing the CAPT Software2-26
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2 Open [My Computer], then select the CD-ROM drive.

3 Select [Open] from the [File] menu.
2-27Installing the CAPT Software
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4 Double-click the [Print_Monitor_Installer] folder.

5 Double-click the [English] folder.

6 Double-click [Setup.exe].

The installer of Canon CAPT Print Monitor starts.
Installing the CAPT Software2-28
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7 Click [Next].

8 Confirm the contents and select [I accept the terms in the 
license agreement], and then click [Next].

9 Click [Next].
2-29Installing the CAPT Software
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IMPORTANT
When using the unicast communication mode, you need to configure the network 
board (print server) to be used in the unicast communication mode. For more 
details, see "Using the Unicast Communication Mode" (p. 5-12), or ask your 
network administrator.

If you are using Windows XP Service Pack 2 or another operating system 
equipped with Windows Firewall, and when the following screen appears, select 
[Yes], and then click [Next].

10 Click [Start].

Installation of Canon CAPT Print Monitor starts.
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11 Click [Exit].

Next, install the printer driver (See p. 2-31).

Installing the Printer Driver from [Add Printer Wizard]

� For Windows 98/Me

NOTE
The screen shots used in this section are from Windows Me.

1 Make sure that the computer and printer are connected via the 
network and that the printer is ON.

2 From the [Start] menu, select [Settings] � [Printers] to open 
the [Printers] folder. Then, double-click [Add Printer].

The [Add Printer Wizard] dialog box is displayed.

NOTE
The [Add Printer Wizard] dialog box can also be displayed using the following 
procedure:
- Double-click [My Computer] � [Control Panel] � [Printers] � [Add Printer] (For 

Windows Me).
- Double-click [My Computer] � [Printers] � [Add Printer] (For Windows 98).
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3 Click [Next].

4 Select [Local printer], then click [Next].

NOTE
This screen does not appear when the network settings have not been configured.

5 Click [Have Disk].
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6 Insert the supplied CD-ROM into the CD-ROM drive, and then 
click [Browse].

If CD-ROM Setup appears, click [Exit].

7 Select [D:\English\Win98_Me], then click [OK].

The CD-ROM drive name is indicated as "D:" in this manual. The CD-ROM drive 
name may differ depending on the computer you are using.

8 Confirm the contents of [Copy manufacturer's files from], then 
click [OK].

For example, when your CD-ROM drive is drive [D:], it is displayed as 
[D:\English\Win98_Me].
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9 Select the name of this printer for [Printers], then click [Next].

10 Select [LPT1], then click [Next].

NOTE
Do not select [Canon CAPT Port] at this point.

11 Enter a new name in [Printer Name] if you want to change the 
printer name.
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NOTE
If another printer driver has already been installed in the computer, the message 
<Do you want your Windows-based programs to use this printer as the default 
printer?> appears. In this case, select [Yes] or [No].

12 Click [Finish].

Copying files is started.

13 When the dialog box for completing the installation appears, 
click [OK].

14 From the [Start] menu, select [Settings] � [Printers].

15 Select the icon for the printer you are using.
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16 Select [Properties] from the [File] menu.

17 Display the [Details] sheet.
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18 Select [Canon CAPT Port] from [Print to the following port], 
and then proceed to Step 23.

If [Canon CAPT Port] is not displayed in [Print to the following port], perform the 
following procedure. 

19 Click [Add Port].
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20 Select [Other], then select [Canon CAPT Port].

NOTE
If [Canon CAPT Port] is not displayed, perform the procedure "Installing the Canon 
CAPT Print Monitor" (p. 2-26) again.

21 Click [OK].

22 From [Available network printers], select the port of the IP 
address specified using NetSpot Device Installer, the ARP/
PING command, or the Printer Status Window, and then click 
[OK].
Installing the CAPT Software2-38



S
et

tin
g 

U
p 

th
e 

N
et

w
or

k 
E

nv
iro

nm
en

t f
or

 P
rin

tin
g

2

If the IP address of the desired port is not displayed in [Available network 
printers], enter the IP address specified using NetSpot Device Installer, the ARP/
PING command, or the Printer Status Window, and then click [Add].

NOTE
When using the unicast communication mode (If you have selected the [Use the 
Unicast Communicate Mode] check box on the installation of Canon CAPT Print 
Monitor), display screens and operation procedure are different. For more details,  
see "Using the Unicast Communication Mode" (p. 5-12) or ask your network 
administrator.

23 Click [OK].

The installation of the printer driver is completed. If you want to configure the protocol 
settings, see "Protocol Settings for the Printer," on p. 2-60.
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� For Windows 2000

IMPORTANT
When printing a test page, make sure that the printer is properly connected to the 
computer and the printer is ON before installing the printer driver.

1 Make sure that the computer and printer are connected via the 
network and that the printer is ON.

2 Turn the computer on and start up Windows 2000.

3 Log on as a member of Administrators.

NOTE
Full Control Permission is required for the installation of the printer driver.

4 From the [Start] menu, select [Settings] � [Printers] to open 
the [Printers] folder. Then, double-click [Add Printer].

The [Add Printer Wizard] dialog box is displayed.

5 Click [Next].
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6 Make sure that [Local printer] is selected, then click [Next].

NOTE
Do not select the [Automatically detect and install my Plug and Play printer] check 
box.

7 Select [Create a new port].
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8 Select [Canon CAPT Port] from [Type], then click [Next].

NOTE
If [Canon CAPT Port] is not displayed, perform the procedure "Installing the Canon 
CAPT Print Monitor" (p. 2-26) again.

9 From [Available network printers], select the port of the IP 
address specified using NetSpot Device Installer, the ARP/
PING command, or the Printer Status Window, and then click 
[OK].

If the IP address of the desired port is not displayed in [Available network 
printers], enter the IP address specified using NetSpot Device Installer, the ARP/
PING command, or the Printer Status Window, and then click [Add].
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NOTE
When using the unicast communication mode (If you have selected the [Use the 
Unicast Communicate Mode] check box on the installation of Canon CAPT Print 
Monitor), display screens and operation procedure are different. For more details, 
see "Using the Unicast Communication Mode" (p. 5-12) or ask your network 
administrator.

10 Click [Have Disk].

11 Insert the supplied CD-ROM into the CD-ROM drive, and then 
click [Browse].

If CD-ROM Setup appears, click [Exit].
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12 Select [D:\English\Win2K_XP]. Select the INF file, then click 
[Open].

The CD-ROM drive name is indicated as "D:" in this manual. The CD-ROM drive 
name may differ depending on the computer you are using.

13 Confirm the contents of [Copy manufacturer's files from], then 
click [OK].

For example, when your CD-ROM drive is drive [D:], it is displayed as 
[D:\English\Win2K_XP].

14 Click [Next].
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15 Enter a new name in [Printer name] if you want to change the 
printer name, then click [Next].

NOTE
If another printer driver has already been installed in the computer, the message 
<Do you want your Windows-based programs to use this printer as the default 
printer?> appears. In this case, select [Yes] or [No].

16 Click [Next].

NOTE
When sharing this printer on a network, select [Share as], and then click [Next]. 
The window for entering [Location] and [Comment] is displayed. Enter them as 
needed, then click [Next].
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17 When printing a test page, click [Yes], then click [Next].

18 Click [Finish].

Copying files is started.

When printing a test page, a dialog box will appear after printing. Click [OK] to 
close the dialog box.

NOTE
If the [Digital Signature Not Found] dialog box appears, click [Yes].

The installation of the printer driver is completed. If you want to configure the protocol 
settings, see "Protocol Settings for the Printer," on p. 2-60.
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� For Windows XP/Server 2003

IMPORTANT
When printing a test page, make sure that the printer is properly connected to the 
computer and the printer is ON before installing the printer driver.

NOTE
The screen shots used in this section are from Windows XP Professional.

1 Make sure that the computer and printer are connected via the 
network and that the printer is ON.

2 Turn the computer on and start up Windows XP/Server 2003.

3 Log on as a member of Administrators.

NOTE
Full Control Permission is required for the installation of the printer driver.

4 Display the [Printers and Faxes] folder.

For Windows XP Professional/Server 2003
From the [Start] menu, select [Printers and Faxes].

For Windows XP Home Edition
From the [Start] menu, select [Control Panel], and then click [Printers and Other 
Hardware] � [Printers and Faxes].
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5 Click [Add a printer].

For Windows Server 2003: Double-click [Add Printer].

6 Click [Next].
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7 Make sure that [Local printer attached to this computer] is 
selected, then click [Next].

NOTE
Do not select the [Automatically detect and install my Plug and Play printer] check 
box.

8 Select [Create a new port].
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9 Select [Canon CAPT Port] from [Type of port], then click 
[Next].

NOTE
If [Canon CAPT Port] is not displayed, perform the procedure "Installing the Canon 
CAPT Print Monitor" (p. 2-26) again.

10 From [Available network printers], select the port of the IP 
address specified using NetSpot Device Installer, the ARP/
PING command, or the Printer Status Window, and then click 
[OK].

If the IP address of the desired port is not displayed in [Available network 
printers], enter the IP address specified using NetSpot Device Installer, the ARP/
PING command, or the Printer Status Window, and then click [Add].
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NOTE
When using the unicast communication mode (If you have selected the [Use the 
Unicast Communicate Mode] check box on the installation of Canon CAPT Print 
Monitor), display screens and operation procedure are different. For more details, 
see "Using the Unicast Communication Mode" (p. 5-12), or ask your network 
administrator.

11 Click [Have Disk].

12 Insert the supplied CD-ROM into the CD-ROM drive, and then 
click [Browse].

If CD-ROM Setup appears, click [Exit].
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13 Select [D:\English\Win2K_XP]. Select the INF file, then click 
[Open].

The CD-ROM drive name is indicated as "D:" in this manual. The CD-ROM drive 
name may differ depending on the computer you are using.

14 Confirm the contents of [Copy manufacturer's files from], then 
click [OK].

For example, when your CD-ROM drive is drive [D:], it is displayed as 
[D:\English\Win2K_XP].

15 Click [Next].
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16 Enter a new name in [Printer name] if you want to change the 
printer name, then click [Next].

NOTE
If another printer driver has already been installed in the computer, the message 
<Do you want to use this printer as the default printer?> appears. In this case, 
select [Yes] or [No].

17 Click [Next].

NOTE
When sharing this printer on a network, select [Share name], and then click [Next]. 
The window for entering [Location] and [Comment] is displayed. Enter them as 
needed, then click [Next].
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18 When printing a test page, click [Yes], then click [Next].

19 Click [Finish].

Copying files is started.

When printing a test page, a dialog box will appear after printing. Click [OK] to 
close the dialog box.

IMPORTANT
If you are using a computer with Windows XP Service Pack 2 or another operating 
system equipped with Windows Firewall as the print server, you need to configure 
Windows Firewall to unblock communication with the client computers. For details 
on configuring Windows Firewall to unblock communication, see "User's Guide".

NOTE
If the [Hardware Installation] dialog box appears, click [Continue Anyway].

The installation of the printer driver is completed. If you want to configure the protocol 
settings, see "Protocol Settings for the Printer," on p. 2-60.
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When the installation of the CAPT software is completed, an icon and folder for this 
printer will be created as follows.

� For Windows 98/Me/2000
• The icon for the printer is displayed in the [Printers] folder.

• [Canon Printer Uninstaller] is added to [Programs] under the [Start] menu.

• If the manuals are installed, [LBPxxxx Online Manuals] is created on the desktop. (xxxx 
varies depending on the printer.)
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� For Windows XP/Server 2003
• The icon for this printer is displayed in the [Printers and Faxes] folder.

• [Canon Printer Uninstaller] is added to [All Programs] under the [Start] menu.

• If the manuals are installed, [LBPxxxx Online Manuals] is created on the desktop. (xxxx 
varies depending on the printer.)
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Before using the printer for the first time, be sure to perform Network Status Print to 
check the operations using the following procedure. Network Status Print prints the 
version of the optional network board or the TCP/IP settings.

NOTE
• Network Status Print is designed to be printed on A4 size paper. Load A4 size paper.
• The screen shots used in this section are from Windows XP Professional.

1 Display the [Printers and Faxes] folder or the [Printers] folder.

For Windows 98/Me/2000: From the [Start] menu, select [Settings] � [Printers].
For Windows XP Professional/Server 2003: From the [Start] menu, select [Printers 
and Faxes].
For Windows XP Home Edition: From the [Start] menu, select [Control Panel], and 
then click [Printers and Other Hardware] � [Printers and Faxes].

2 Select the icon for this printer, then select [Printing 
Preferences] from the [File] menu.

For Windows 98/Me: Select the icon for this printer, then select [Properties] from 
the [File] menu.
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3 Display the [Page Setup] sheet, then click [ ] (Display 
Printer Status Window) to run the Printer Status Window.

NOTE
For details on the Printer Status Window, see "User's Guide".

4 From the [Options] menu, select [Utility] � [Network Status 
Print].
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5 Click [OK].

Network Status Print is printed.

IMPORTANT
This is a sample of Network Status Print. The contents may differ from the Network 
Status Print printed by your computer.

NOTE
If the Network Status Print is not printed properly, see "Chapter 4 Troubleshooting".
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Protocol Settings for the Printer
After installing the printer driver, perform the protocol settings for the printer as 
needed. You can perform the protocol settings from the computer you are using, 
using any one of the following software.

� Protocol Settings Using the Remote UI (See p. 2-60)
Perform the protocol settings by accessing the printer from your web browser via the 
network.

� Protocol Settings Using NetSpot Device Installer (See p. 2-70)
Perform the basic protocol settings by starting NetSpot Device Installer from the supplied 
CD-ROM or the one installed. When configuring the DNS server etc., use the Remote UI 
or FTP Client.

� Protocol Settings Using FTP Client (See p. 2-74)
Perform the protocol settings by accessing the FTP server in the network board using 
Command Prompt (MS-DOS Prompt for Windows 98/Me).

 

Protocol Settings Using the Remote UI

1 Run the web browser, enter the following URL in [Location] or 
[Address], and then press the [ENTER] key on your keyboard.

http://<the IP address or name of the printer>/

Input Example : http://192.168.0.215/

IMPORTANT
• If you are not sure about the IP address of this printer, refer to the Network Status 

Print printed in "Checking the Operations with Network Status Print" (p. 2-57) or 
ask an administrator of the printer.

• Use Netscape Navigator/Communicator 4.7 or later or Internet Explorer 4.01SP1 
or later as the web browser.

• You cannot connect the computer to the printer via a proxy server. If you are using 
a proxy server, perform the following settings. (The setting varies depending on the 
network environment.)
- On the settings for the proxy server of the web browser, add the IP address of this 

printer to [Exceptions] (The addresses that do not use the proxy server).
• Configure the web browser so that you can use Cookie.
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• If multiple Remote UIs are running simultaneously, the latest setting is effective. It 
is recommended that only one Remote UI should be running at a time.

NOTE
Depending on the system environment, the screen for the Remote UI is not 
displayed. In this case, enter "http://<the IP address of this printer>/cab/top.shtml" 
in [Address] or [Location] to redisplay the screen.

2 Click [Log In].

NOTE
If a password is specified for the printer, enter the password, and then click [Log In]. 
If the password has not been specified yet, it is not required to enter the password.
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3 Click [Network] from the [Device Manager] menu.

4 Click [Change] under [TCP/IP].
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5 Specify [IP Address], [Subnet Mask], and [Gateway Address].

Enter the IP address of the printer in [IP Address]. Enter the addresses used in 
the TCP/IP network in [Subnet Mask] and [Gateway Address].

NOTE
• Even if you are using any one of DHCP, BOOTP, or RARP, specify [IP Address], 

[Subnet Mask], and [Gateway Address]. If you cannot obtain information from the 
servers of DHCP, BOOTP, and RARP, the values specified here are used.

• If you specify to use any one of DHCP, BOOTP, or RARP, the values obtained from 
those are displayed after resetting the network board (If the values have been 
specified previously, they overwrite the obtained ones).
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6 Specify the method for setting the IP address of the printer as 
needed. Among [DHCP], [BOOTP], and [RARP], set any option 
that you want to use for the IP address setting to [On].

As well as by assigning the IP address directly, you can set the IP address by 
using any one of DHCP, BOOTP, or RARP. When restarting or resetting the printer, 
whether DHCP, BOOTP, and RARP are available is checked, and the IP address 
is assigned by the method that is determined to be available the soonest. If you 
set [DHCP], [BOOTP], or [RARP] to [Off], the corresponding protocol is not 
checked.
If you can use none of these, assign the IP address specified in [IP Address].

NOTE
• Because it takes one to two minutes to check whether DHCP, BOOTP, and RARP 

are available, it is recommended that you set the unused protocol(s) to [Off].
• To assign the IP address using DHCP, BOOTP, or RARP, the DHCP server, BOOTP 

daemon, or RARP daemon needs to be started up.
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7 Specify the settings for [DNS Settings] as needed.

❑ Enter the IP address of the DNS server in [DNS Server Address].

❑ When using the DNS Dynamic Update function, set [DNS Dynamic Update] to 
[On].

❑ Specify the host name to be added to the DNS server in [DNS Host Name].

❑ Enter the name of the domain to which this printer belongs in [DNS Domain 
Name].

Input Example : example.com

IMPORTANT
• DNS Dynamic Update is a function that adds the IP address of the device and the 

names specified as the host name and domain name to the DNS server 
automatically. This function can be used in the environment in which a Dynamic 
DNS server is being used.

• To use the DNS Dynamic Update function, you need to specify the IP address, host 
name, and domain name of the DNS server.

NOTE
DNS is used when performing name resolution using the SNTP server name 
(When you specify the SNTP server name in Step 9).
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8 Specify the settings for [WINS Settings].

� When using WINS Resolution

❑ Set [WINS Resolution] to [On].

❑ Enter the IP address of the WINS server in [WINS Server Address].

❑ Enter the host name to be added to the WINS server in [WINS Host Name].

❑ In [Scope ID], enter the Scope ID of the NetBIOS name that you want to search 
for from the WINS server.

You can refine the search by separating the character string with periods (.).

� When not using WINS Resolution

❑ Set [WINS Resolution] to [Off].
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9 Specify [SNTP] when using SNTP Client to obtain the time.

� If you have specified the settings for DNS in Step 7

❑ Enter the server name of the SNTP server in [SNTP Server Name].

❑ Select [Time Zone].

❑ To set daylight saving time, set [Daylight Saving Time] to [On].

� If you have not specified the settings for DNS in Step 7

❑ Enter the IP address of the SNTP server in [SNTP Server Name].

❑ Select [Time Zone].

❑ To set daylight saving time, set [Daylight Saving Time] to [On].

NOTE
• When you cannot use the SNTP server function, you can report the time set on the 

computer to the printer using the following procedure. For details on the Printer 
Status Window, see "User's Guide".

1. Display the Printer Status Window.
2. Select [Preferences] from the [Options] menu.
3. Set [Monitor Printer Status] in the [Preferences] dialog box to [Always], and 

then select the [Notify the Printer of the Time] check box.
• Time Zone: The standard time zones of the world are expressed globally in terms 

of the difference in hours (± up to 12 hours) from GMT* (± 0 hours). A time zone is 
a region throughout which this time difference is the same.
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*The time at the Greenwich Observatory in England is called GMT (Greenwich Mean Time).

• Daylight Saving Time: In some countries and regions, time is advanced throughout 
the summer season. The period in which this is applied is called "Daylight Saving 
Time."

10 Specify the settings for [Multicast Discovery Settings].

NOTE
Multicast discovery is a function that searches for certain devices using the service 
location protocol (SLP). By using the multicast discovery function, you can search 
for only the devices whose values in [Scope Name] are verified, using the service 
location protocol (SLP) from utility software, such as NetSpot Device Installer and 
NetSpot Console.

� When setting the printer so that it responds to searches that used 
the multicast discovery function

❑ Set [Response] to [On].

❑ In [Scope Name], enter the scope name to be used when searching for certain 
devices from utility software, such as NetSpot Device Installer and NetSpot 
Console, by multicast.

� When setting the printer so that it does not response to searches 
that used the multicast discovery function

❑ Set [Response] to [Off].
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11 Click [OK].
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12 When the following screen is displayed, click [Reset] to reset 
the network board.

After completing the reset of the network board, the settings are effective.

NOTE
The settings also become effective by restarting the printer (Turn OFF the printer 
once, wait for 10 seconds or longer, and then turn it ON).

The protocol settings for the printer are now completed.

Protocol Settings Using NetSpot Device Installer
NetSpot Device Installer allows you to perform the basic protocol settings. When 
configuring the DNS server etc., use the Remote UI or FTP Client.

IMPORTANT
If you are using Windows XP Service Pack 2 or another operating system equipped with 
Windows Firewall, and the Windows Firewall is enabled, you cannot search for the 
printers on a subnet that is different from the one that the computers using NetSpot 
Device Installer are on. To search for a printer on a subnet that is different from the one 
that the computer you are using is on, see Readme of NetSpot Device Installer and add 
"NetSpot Device Installer" to the [Exceptions] sheet in the [Windows Firewall] dialog box.
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NOTE
This section describes the procedure for running NetSpot Device Installer from the 
supplied CD-ROM. The procedure for running NetSpot Device Installer when it is 
installed on the computer is as follows. For details on the procedures for installing 
NetSpot Device Installer, see "Installing NetSpot Device Installer," on p. 3-46.
- If NetSpot Device Installer is added to the [Start] menu on the installation

From the [Start] menu, select [Programs] ([All Programs] for Windows XP/Server 2003) 
� [NetSpot Device Installer] � [NetSpot Device Installer].

- If NetSpot Device Installer is not added to the [Start] menu on the installation
Double-click [nsdi.exe] in the folder in which NetSpot Device Installer is installed.

1 Insert the supplied CD-ROM into the CD-ROM drive.

2 Click [Additional Software Programs].

3 Click [Start] in [NetSpot Device Installer for TCP/IP].

If the [License Agreement] dialog box appears, click [Yes].
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4 Select the printer.

IMPORTANT
If you are using Windows XP Service Pack 2 or another operating system equipped 
with Windows Firewall, and the Windows Firewall is enabled, you cannot search for 
the printers on a subnet that is different from the one that the computers using 
NetSpot Device Installer are on. To search for a printer on a subnet that is different 
from the one that the computer you are using is on, see Readme of NetSpot Device 
Installer and add "NetSpot Device Installer" to the [Exceptions] sheet in the 
[Windows Firewall] dialog box.

5 Select [Protocol Settings] from the [Device] menu.
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6 Perform the protocol settings.

Options to be specified

NOTE
• If RARP, BOOTP, or DHCP is selected, you cannot enter any value in [IP Address], 

[Subnet Mask], and [Gateway Address].
• If you cannot use RARP, BOOTP, and DHCP, specify [Manual Setting].

[IP Address Setting with]: Select the method for setting the IP address.

[Manual 
Setting]:

Allows you to specify the IP address 
directly. The IP address entered for [IP 
Address] is specified for the network board.

[Auto Detect]: Obtains an IP address using RARP, 
BOOTP, or DHCP.

[RARP]: Obtains an IP address using RARP. (The 
RARP daemon needs to be started up.)

[BOOTP]: Obtains an IP address using BOOTP. (The 
BOOTP daemon needs to be started up.)

[DHCP]: Obtains an IP address using DHCP. (The 
DHCP server needs to be started up.)

[IP Address]: Enter the IP address of the network board.

[Subnet Mask]: Enter the subnet mask that is being used on the TCP/IP 
network.

[Gateway Address]: Enter the gateway address that is being used on the TCP/IP 
network.
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7 After completing the settings, click [OK].

8 When the message <The device has been reset.> appears, 
click [OK].

After completing the reset, the settings are enabled.

The protocol settings for the printer are now completed.

 

Protocol Settings Using FTP Client

1 Run Command Prompt or MS-DOS Prompt.

For Windows XP/Server 2003: From the [Start] menu, select [All Programs] � 
[Accessories] � [Command Prompt].
For Windows 2000: From the [Start] menu, select [Programs] � [Accessories] � 
[Command Prompt].
For Windows Me: From the [Start] menu, select [Programs] � [Accessories] � 
[MS-DOS Prompt].
For Windows 98: From the [Start] menu, select [Programs] � [MS-DOS Prompt].

2 Enter the following command, then press the [ENTER] key on 
your keyboard.

ftp <the IP address of the printer>

NOTE
If you are not sure about the IP address of this printer, refer to the Network Status 
Print printed in "Checking the Operations with Network Status Print" (p. 2-57) or 
ask an administrator of the printer.

3 Enter "root" as the user name, then press the [ENTER] key on 
your keyboard.

� If the password is specified for the printer

❑ Enter the password.

� If the password is not specified for the printer

❑ Do not enter the password, but press the [ENTER] key on your keyboard.
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NOTE
You can log in by entering a name other than "root" (or leaving the field blank). In 
this case, you can perform operations other than settings.

4 Enter the following command, then press the [ENTER] key on 
your keyboard.

get config <File Name>

The config file is downloaded. The letters entered for <File Name> become the 
name of the downloaded config file.

IMPORTANT
For Windows 98/Me, do not enter "config" for <File Name>.

NOTE
The download directory for the config file varies depending on the operating 
system or settings. If you cannot find the config file, browse the config file using the 
file browse function of the operating system.

5 Using Notepad, etc., edit the downloaded config file.

For details on descriptions of each option, see "Network Setting Items," on p. 5-2.

6 Enter the following command, then press the [ENTER] key on 
your keyboard.

put  <File Name> CONFIG

NOTE
In <File Name>, enter the name of the config file that was entered when the file 
was downloaded.

7 Enter the following command, then press the [ENTER] key on 
your keyboard to reset the network board.

get reset

After completing the reset of the network board, the settings are effective.

NOTE
The settings also become effective by restarting the printer (Turn OFF the printer 
once, wait for 10 seconds or longer, and then turn it ON).
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8 Enter "quit", then press the [ENTER] key on your keyboard.

9 Enter "exit", then press the [ENTER] key on your keyboard.

Command Prompt or MS-DOS Prompt exits.

The protocol settings for the printer are now completed.
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The process of removing software to restore the computer to the same state as 
before the software was installed is referred to as uninstallation. The CAPT 
software can be uninstalled using the following procedure.

• Uninstalling the Printer Driver (See p. 2-77)

• Uninstalling Canon CAPT Print Monitor (See p. 2-79)

• Uninstalling NetSpot Device Installer (See p. 2-81)

IMPORTANT
• If the manuals have already been installed, you can also uninstall the installed manuals 

by uninstalling the printer driver with the Uninstaller.
• If the printer driver was installed on Windows 2000/XP/Server 2003 logged on by a user 

who is a member of Administrators, it cannot be uninstalled from the computer logged on 
by anyone other than users who are members of Administrators. Be sure to log in as a 
member of Administrators before the uninstallation.

• If the printer driver is installed, Canon CAPT Print Monitor cannot be uninstalled. 
Uninstall the printer driver before uninstalling Canon CAPT Print Monitor.

• If you are using a computer with Windows XP Service Pack 2 or another operating 
system equipped with Windows Firewall, the printer is registered in the [Exceptions] 
sheet in the [Windows Firewall] dialog box. When you uninstall the CAPT software using 
the uninstaller, the settings for this printer are also removed from the [Exceptions] sheet 
in the [Windows Firewall] dialog box.

NOTE
• For details on NetSpot Console, see the Readme file of NetSpot Console.
• The screen shots used in this section are from Windows XP Professional.

Uninstalling the Printer Driver

1 Close all of the files and programs listed below:
• Help files
• Printer Status Window
• Control Panel
• Other applications
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2 From the [Start] menu, select [All Programs] � [Canon Printer 
Uninstaller] � [Canon LBPxxxx Uninstaller]. (xxxx varies 
depending on the printer.)

For Windows 98/Me/2000: From the [Start] menu, select [Programs] � [Canon 
Printer Uninstaller] � [Canon LBPxxxx Uninstaller]. (xxxx varies depending on 
the printer.)

3 Select the name of this printer, then click [Delete].

NOTE
Even if this printer is not on the list in the [Delete Printer] dialog box, you can delete 
the file and information related to this printer by clicking [Delete].

4 Click [Yes].

Uninstallation starts. Please wait a moment.
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5 Click [Exit].

NOTE
If the CAPT software cannot be uninstalled, see "When Uninstallation Fails," on p. 
4-3.

Uninstalling Canon CAPT Print Monitor

IMPORTANT
If the printer driver is installed, Canon CAPT Print Monitor cannot be uninstalled. 
Uninstall the printer driver before uninstalling Canon CAPT Print Monitor.

1 Close all of the files and programs listed below:
• Help files
• Control Panel
• Other applications

2 From the [Start] menu, select [Control Panel], click [Add or 
Remove Programs], and then close [Control Panel].

For Windows 98/Me/2000: From the [Start] menu, select [Settings] � [Control 
Panel], and then double-click [Add/Remove Programs].
For Windows Server 2003: From the [Start] menu, select [Control Panel] � [Add 
or Remove Programs].
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3 Select [Canon CAPT Print Monitor] in the [Add or Remove 
Programs] dialog box, then click [Change/Remove].

For Windows 98/Me: Select [Canon CAPT Print Monitor] in the [Add/Remove 
Programs Properties] dialog box, then click [Add/Remove].
For Windows 2000: Select [Canon CAPT Print Monitor] in the [Add/Remove 
Programs] dialog box, then click [Change/Remove].

4 The dialog box that asks you whether the uninstallation can 
be started is displayed. Click [Yes].

Uninstallation starts. Please wait a moment.

5 If the uninstallation is completed successfully, the dialog box 
that informs you of the completion of the uninstallation is 
displayed. Click [OK].
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Uninstalling NetSpot Device Installer

1 From the [Start] menu, select [All Programs] � [NetSpot 
Device Installer] � [Uninstall NetSpot Device Installer].

For Windows 98/Me/2000: From the [Start] menu, select [Programs] � [NetSpot 
Device Installer] � [Uninstall NetSpot Device Installer].

Command Prompt (MS-DOS Prompt for Windows 98/Me) is displayed, and the 
uninstallation starts. Please wait a moment.
For Windows 2000/XP/Server 2003, the uninstallation is completed when 
Command Prompt exits.
For Windows 98/Me, the uninstallation is completed when the message "NetSpot 
Device Installer has been uninstalled successfully." is displayed.

NOTE
If you did not add NetSpot Device Installer to the [Start] menu when you installed it, 
double-click [rmnsdi.bat] in the folder in which NetSpot Device Installer is installed.
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Managing the Printer
You can perform the printer management, such as checking the printer status and 
specifying various settings, in a network environment using the following software. 
The specifiable options vary depending on the software. See "Network Setting 
Items" (p. 5-2) and use software appropriate to the network environment you are 
using or options that you want to specify.

� Remote UI (See p. 3-3)
The Remote UI is software that allows you to manage the printer using a web browser. By 
accessing the printer from the web browser via a network, you can check the printer 
status or job history, and configure the network or security settings.

� NetSpot Device Installer (See p. 3-45)
NetSpot Device Installer is software included on the supplied CD-ROM. Without installing 
it, you can run NetSpot Device Installer from the supplied CD-ROM and specify the 
settings for the protocols or device information.

� FTP Client (See p. 3-42)
FTP Client allows you to specify the settings for various information about the device and 
configure the network and security by accessing the FTP server on the network board 
using Command Prompt (MS-DOS Prompt for Windows 98/Me).

� NetSpot Console (See Online Manual)
NetSpot Console is software that allows you to manage the printers connected on a 
network using the web browser that you have. NetSpot Console allows you to view a list of 
printers, display a printer map, and view a variety of printer information.

 

IMPORTANT
When using NetSpot Console, it needs to be installed on any one of the computers on 
the network. If NetSpot Console is installed on none of the computers, install NetSpot 
Console. For details on the installation procedure, see Readme of NetSpot Console. For 
more details on the setting procedure, see the online manual of NetSpot Console.

NOTE
Install NetSpot Console by downloading it from the Canon website.
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This section describes the procedures for performing the following management 
options using the Remote UI.

• Restricting the Users Who Can Print (See p. 3-4)

• Restricting the Users Who Can Monitor/Change the Settings Using the SNMP 
Protocol (See p. 3-10)

• Restricting the Users Who Can Perform the Multicast Discovery (See p. 3-18)

• Restricting the Devices That Can Access with MAC Addresses (See p. 3-23)

• Obtaining/Checking the Security Access Logs (See p. 3-29)

• Initializing the Network Settings (See p. 3-37)

You can also perform these management options using FTP Client.

IMPORTANT
• If you are not sure about the IP address of this printer, refer to the Network Status Print 

(See "Checking the Operations with Network Status Print," on p. 2-57) or ask the 
administrator of the printer.

• Use Netscape Navigator/Communicator 4.7 or later or Internet Explorer 4.01SP1 or later 
as the web browser.

• You cannot connect the computer to the printer via a proxy server. If you are using a 
proxy server, perform the following settings. (The setting varies depending on the 
network environment.)
- On the settings for the proxy server of the web browser, add the IP address of this 

printer to [Exceptions] (The addresses that do not use the proxy server).
• Configure the web browser so that you can use Cookie.
• If multiple Remote UIs are running simultaneously, the latest setting is effective. It is 

recommended that only one Remote UI should be running at a time.

NOTE
Depending on the system environment, the screen for the Remote UI is not displayed. In 
this case, enter "http://<the IP address of this printer>/cab/top.shtml" in [Address] or 
[Location] to redisplay the screen.
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Restricting the Users Who Can Print

IMPORTANT
This function restricts print commands only, not access from the Remote UI.

NOTE
• When you try to print from a computer whose IP address is rejected from being used for 

printing, the message <Cannot Print> is displayed.
• When you are using a computer whose IP address is rejected from being used for 

printing, some options cannot be set from the [Options] menu in the Printer Status 
Window.

1 Run the web browser, enter the following URL in [Location] or 
[Address], and then press the [ENTER] key on your keyboard.

http://<the IP address or name of the printer>/

Input Example : http://192.168.0.215/

2 Click [Log In].
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NOTE
If a password is specified for the printer, enter the password, and then click [Log In]. 
If the password has not been specified yet, it is not required to enter the password.

3 Click [Information] from the [Device Manager] menu.
3-5Managing the Printer Using the Remote UI



M
an

ag
in

g 
th

e 
P

rin
te

r 
in

 th
e 

N
et

w
or

k 
E

nv
iro

nm
en

t

3

4 Click [Change] on the right of [Security].

5 Select the [Restrict TCP/IP Printing] check box.
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6 Select [Permit Specified Addresses] or [Reject Specified 
Addresses].

NOTE
When [Permit Specified Addresses] is selected, only users specified in [IP 
Addresses] are permitted to perform printing. When [Reject Specified Addresses] 
is selected, only users specified in [IP Addresses] are rejected from performing 
printing.
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7 Enter the IP address of a computer of which you want to 
permit or reject printing, and then click [Add].

Enter the IP address by separating the numbers with a period (.), for example, 
AAA.BBB.C.DD. You can also enter the address as follows.

Input example of the IP 
addresses

Method for entering IP addresses

AAA.BBB.C.15-AAA.BBB.C.18

If you want to enter the IP addresses of 
consecutive numbers, place a hyphen 
between the address of the smallest number 
and that of the largest number. The example 
on the left is equivalent to entering 
addresses from AAA.BBB.C.15 to 
AAA.BBB.C.18.

AAA.BBB.C.*

Entering "*" is equivalent to entering the 
numbers from 0 to 255. The example on the 
left is equivalent to entering addresses from 
AAA.BBB.C.0 to AAA.BBB.C.255.
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To delete an IP address, select the IP address and click [Delete].

8 Click [OK].
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Restricting the Users Who Can Monitor/Change the 
Settings Using the SNMP Protocol

1 Run the web browser, enter the following URL in [Location] or 
[Address], and then press the [ENTER] key on your keyboard.

http://<the IP address or name of the printer>/

Input Example : http://192.168.0.215/

2 Click [Log In].

NOTE
If a password is specified for the printer, enter the password, and then click [Log In]. 
If the password has not been specified yet, it is not required to enter the password.
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3 Click [Information] from the [Device Manager] menu.

4 Click [Change] on the right of [Security].
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5 Specify the SNMPv1 protocol.

� When using the SNMPv1 protocol

❑ Set [SNMPv1] to [On].

❑ For [Access Rights], select in which mode the SNMPv1 agent can operate, 
[Read-only] or [Read and Write].

❑ Specify the community name of SNMP in [Community Name].

IMPORTANT
Selecting [Read-only] disables overwriting, and you cannot use some functions of 
Canon utility software or cannot use the software properly due to an error 
occurring.

� When not using the SNMPv1 protocol

❑ Set [SNMPv1] to [Off].

IMPORTANT
If [SNMPv1] is set to [Off], you may not be able to use Canon utility software. 
Consult the administrator of the printer before selecting [Off].
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6 Specify the SNMPv3 protocol.

� When using the SNMPv3 protocol

❑ Set [SNMPv3] to [On].

❑ Specify the authentication key or privacy key to be used in SNMPv3 in 
[Authentication Key/Privacy Key].

❑ Enter the administrator password for the Remote UI in [Administrator 
Password].

IMPORTANT
If the settings for the SNMPv3 protocol is specified using application other than the 
Remote UI, the settings are not displayed in the Remote UI. To display the settings 
again, reset the network board to the default settings. For details on the procedure 
for resetting the print server to the default settings, see "Initializing the Network 
Settings," on p. 5-8.

NOTE
• The user name to be used for the SNMPv3 protocol is set to "initial".
• If the password for the Remote UI is not specified, it is not required to enter a 

password in [Administrator Password].

� When not using the SNMPv3 protocol

❑ Set [SNMPv3] to [Off].
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7 Select the [Restrict SNMP Monitoring/Setting Changes] check 
box.
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8 Select [Permit Specified Addresses] or [Reject Specified 
Addresses].

NOTE
When [Permit Specified Addresses] is selected, only users specified in [IP 
Addresses] are permitted to monitor/change the settings. When [Reject Specified 
Addresses] is selected, only users specified in [IP Addresses] are rejected from 
monitoring/changing the settings.
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9 Enter the IP address of a computer of which you want to 
permit or reject monitoring/changing the settings for the 
device, and then click [Add].

Enter the IP address by separating the numbers with a period (.), for example, 
AAA.BBB.C.DD. You can also enter the address as follows.

Input example of the IP 
addresses

Method for entering IP addresses

AAA.BBB.C.15-AAA.BBB.C.18

If you want to enter the IP addresses of 
consecutive numbers, place a hyphen 
between the address of the smallest number 
and that of the largest number. The example 
on the left is equivalent to entering 
addresses from AAA.BBB.C.15 to 
AAA.BBB.C.18.

AAA.BBB.C.*

Entering "*" is equivalent to entering the 
numbers from 0 to 255. The example on the 
left is equivalent to entering addresses from 
AAA.BBB.C.0 to AAA.BBB.C.255.
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To delete an IP address, select the IP address and click [Delete].

10 Click [OK].
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Restricting the Users Who Can Perform the Multicast 
Discovery

NOTE
Multicast discovery is a function that searches for certain devices using the service 
location protocol (SLP). By using the multicast discovery function, you can search for 
only the devices whose values in [Scope Name] are verified, using the service location 
protocol (SLP) from utility software, such as NetSpot Device Installer and NetSpot 
Console.

1 Run the web browser, enter the following URL in [Location] or 
[Address], and then press the [ENTER] key on your keyboard.

http://<the IP address or name of the printer>/

Input Example : http://192.168.0.215/

2 Click [Log In].

NOTE
If a password is specified for the printer, enter the password, and then click [Log In]. 
If the password has not been specified yet, it is not required to enter the password.
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3 Click [Information] from the [Device Manager] menu.

4 Click [Change] on the right of [Security].
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5 Select the [Restrict Multicast Discovery] check box.

6 Select [Respond to Specified IP Addresses] or [Do Not 
Respond to Specified Addresses].
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NOTE
When [Respond to Specified IP Addresses] is selected, only users specified in [IP 
Addresses] can receive responses to searches that used the multicast discovery 
function. When [Do Not Respond to Specified Addresses] is selected, only users 
specified in [IP Addresses] cannot receive responses to searches that used the 
multicast discovery function.

7 Enter an IP address that can receive or cannot receive 
responses to searches that used the multicast discovery, and 
then click [Add].

Enter the IP address by separating the numbers with a period (.), for example, 
AAA.BBB.C.DD. You can also enter the address as follows.

Input example of the IP 
addresses

Method for entering IP addresses

AAA.BBB.C.15-AAA.BBB.C.18

If you want to enter the IP addresses of 
consecutive numbers, place a hyphen 
between the address of the smallest number 
and that of the largest number. The example 
on the left is equivalent to entering 
addresses from AAA.BBB.C.15 to 
AAA.BBB.C.18.
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To delete an IP address, select the IP address and click [Delete].

AAA.BBB.C.*

Entering "*" is equivalent to entering the 
numbers from 0 to 255. The example on the 
left is equivalent to entering addresses from 
AAA.BBB.C.0 to AAA.BBB.C.255.

Input example of the IP 
addresses

Method for entering IP addresses
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8 Click [OK].

Restricting the Devices That Can Access with MAC 
Addresses

1 Run the web browser, enter the following URL in [Location] or 
[Address], and then press the [ENTER] key on your keyboard.

http://<the IP address or name of the printer>/

Input Example : http://192.168.0.215/
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2 Click [Log In].

NOTE
If a password is specified for the printer, enter the password, and then click [Log In]. 
If the password has not been specified yet, it is not required to enter the password.
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3 Click [Information] from the [Device Manager] menu.

4 Click [Change] on the right of [Security].
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5 Select the [Restrict MAC Address Access] check box.

6 Select [Permit Specified Addresses] or [Reject Specified 
Addresses].
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IMPORTANT
When [Permit Specified Addresses] is selected, you cannot access from an 
unauthorized MAC address. Therefore, confirm the MAC address when entering it. 
If there is no corresponding MAC address, you cannot access the network. In this 
case, you need to initialise the network settings. (See "Initializing the Network 
Settings," on p. 5-8)

7 Enter the MAC address of a device of which you want to 
permit or reject accessing, and then click [Add].

Enter twelve-digit alphanumeric characters as 0123456789ab without separating 
them with a hyphen (-) or colon (:).

NOTE
Up to 20 MAC addresses can be entered.
3-27Managing the Printer Using the Remote UI



   

M
an

ag
in

g 
th

e 
P

rin
te

r 
in

 th
e 

N
et

w
or

k 
E

nv
iro

nm
en

t

 

3

   
To delete a MAC address, select the MAC address and click [Delete].

8 Click [OK].
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Obtaining/Checking the Security Access Logs

Obtaining a Security Access Log
If you have restricted the users who can print, who can monitor/change the settings 
using the SNMP protocol, or who can perform the multicast discovery in [IP 
Address Range Settings], you can obtain a security access log (The date and time 
when the access was locked, IP address, port number, and restriction type) when 
access from a restricted user is blocked. You can select whether to obtain a security 
access log by restriction type.

1 Run the web browser, enter the following URL in [Location] or 
[Address], and then press the [ENTER] key on your keyboard.

http://<the IP address or name of the printer>/

Input Example : http://192.168.0.215/

2 Click [Log In].

NOTE
If a password is specified for the printer, enter the password, and then click [Log In]. 
If the password has not been specified yet, it is not required to enter the password.
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3 Click [Information] from the [Device Manager] menu.

4 Click [Change] on the right of [Security].
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5 Select [On] or [Off] for [Access Logs].

If [On] is selected, the security access log is obtained when access from a user 
who is restricted in [IP Address Range Settings] is blocked.
If [Off] is selected, the security access log is not obtained when access from a 
user who is restricted in [IP Address Range Settings] is blocked.
3-31Managing the Printer Using the Remote UI



M
an

ag
in

g 
th

e 
P

rin
te

r 
in

 th
e 

N
et

w
or

k 
E

nv
iro

nm
en

t

3

6 When [Access Logs] is set to [On], select any security access 
log that you want to obtain from [Log Types].

Options to be specified

NOTE
You can display, [Save], or [Clear] the obtained security access logs in [Security 
Access Log] page. To display the [Security Access Log] page, click [Display Log] in 
the [Information] page in the [Device Manager] menu in the Remote UI. For more 
details, see "Checking the Security Access Logs," on p. 3-33.

[Rejected TCP/IP Print Jobs]: The security access log is recorded when access from a user 
who is restricted to perform the TCP/IP printing is blocked.

[Rejected SNMP Monitoring/
Setting Changes]:

The security access log is recorded when access from a user 
who is restricted to monitor/change the SNMP setting is 
blocked.

[Rejected Multicast 
Discoveries]:

The security access log is recorded when access from a user 
who is restricted to perform the multicast discovery is blocked.
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7 Click [OK].

Checking the Security Access Logs
If you have restricted the users who can print, who can monitor/change the settings 
using the SNMP protocol, or who can perform the multicast discovery in [IP 
Address Range Settings], you can check the security access logs (The date and 
time when the access was locked, IP address, port number, and restriction type) 
that are obtained when access from a restricted user is blocked. It also allows you 
to [Save] or [Clear] the security access logs.

1 Run the web browser, enter the following URL in [Location] or 
[Address], and then press the [ENTER] key on your keyboard.

http://<the IP address or name of the printer>/

Input Example : http://192.168.0.215/
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2 Click [Log In].

NOTE
If a password is specified for the printer, enter the password, and then click [Log In]. 
If the password has not been specified yet, it is not required to enter the password.
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3 Click [Information] from the [Device Manager] menu.

4 Click [Display Log] under [Security].
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5 Check the security access logs in the [Security Access Log] 
page.

aaaa [Update Now]
Clicking this button obtains information about the date and time from the SNTP 
server. Reflects the obtained status to [Date and Time] and the SNTP server 
log according to success or failure of obtaining information.

bbbb [Date and Time]
Displays the date and time obtained from the SNTP server. The local time of 
the network board is displayed when the time and date could not be obtained 
for any reason, such as that the SNTP server address is not specified or there 
is no response from the SNTP server.

cccc [SNTP Server Log]
Displays the obtained status from the SNTP server.
When succeeded in obtaining the time and date from SNTP:

<Synchronized with the SNTP server at "The date and time when they 
were obtained".>
<Next synchronization in "The date and time when they are to be 
obtained next".>

While in the process of obtaining the date and time from SNTP:
<Getting time from SNTP Server.>

When failed to obtain the time and date from SNTP:
<Failed to get time from SNTP Server.>

dddd [Save]
Saves the obtained security access log in text format.

eeee [Clear]
Clears the obtained security access logs.

a

b

c

d

e

f
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ffff [Security Access Log]
Displays the obtained security access logs. The date and time when the 
access was locked, IP address, port number, restriction type (any one of 
[PRINT] (Rejected TCP/IP Print Jobs), [SNMP] (Rejected SNMP Monitoring/
Setting Changes), or [SLP] (Rejected Multicast Discoveries)) are displayed.

NOTE
Up to 100 logs can be obtained. When the number of the logs exceeds 100, the 
logs are deleted starting from the oldest one.

Initializing the Network Settings
If you want to reset the network board to the default values, use any method from 
among Remote UI, FTP Client, and NetSpot Device Installer.

This section describes the procedure for initializing the network settings using the 
Remote UI. For details on initializing the network settings using FTP Client or  
NetSpot Device Installer, see "Initializing the Network Settings," on p. 5-8.

IMPORTANT
Make sure that the printer is not operating before initializing the network settings. If you 
initialize the print server while the printer is printing or receiving data, the received data 
may not be printed properly, or may result in paper jams or damage to the printer.

1 Run the web browser, enter the following URL in [Location] or 
[Address], and then press the [ENTER] key on your keyboard.

http://<the IP address or name of the printer>/

Input Example : http://192.168.0.215/
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2 Click [Log In].

NOTE
If a password is specified for the printer, enter the password, and then click [Log In]. 
If the password has not been specified yet, it is not required to enter the password.
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3 Click [Network] from the [Device Manager] menu.

4 Click [Show Parameter List] in [Network Interface].
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5 Click [Reset to Default Settings]
3-40 Managing the Printer Using the Remote UI



M
an

ag
in

g 
th

e 
P

rin
te

r 
in

 th
e 

N
et

w
or

k 
E

nv
iro

nm
en

t

3

6 Clicking [Yes] initializes the network settings.

Clicking [No] does not initialize the network settings but displays the original 
page.
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Managing the Printer Using FTP Client
You can manage the printer with FTP Client using the following procedure. Also, 
you can upgrade the firmware.

1 Run Command Prompt or MS-DOS Prompt.

For Windows XP/Server 2003: From the [Start] menu, select [All Programs]  � 
[Accessories] � [Command Prompt].
For Windows 2000: From the [Start] menu, select [Programs]  � [Accessories]  
� [Command Prompt].
For Windows Me: From the [Start] menu, select [Programs]  � [Accessories]  � 
[MS-DOS Prompt].
For Windows 98: From the [Start] menu, select [Programs]  � [MS-DOS Prompt].

2 Enter the following command, then press the [ENTER] key on 
your keyboard.

ftp <the IP address of the printer>

NOTE
If you are not sure about the IP address of this printer, refer to the Network Status 
Print printed in "Checking the Operations with Network Status Print" (p. 2-57) or 
ask an administrator of the printer.

3 Enter "root" as the user name, then press the [ENTER] key on 
your keyboard.

If a password is specified for the printer, enter the password. If the password has 
not been specified yet, do not enter the password, but press the [ENTER] key on 
your keyboard.

NOTE
You can log in by entering a name other than "root" (or leaving the field blank). In 
this case, you can perform operations other than settings.
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4 Enter the following command, then press the [ENTER] key on 
your keyboard.

get config <File Name>

The config file is downloaded. The letters entered for <File Name> become the 
name of the downloaded config file.

IMPORTANT
For Windows 98/Me, do not enter "config" for <File Name>.

NOTE
• When upgrading the firmware, enter "put <the update file of the firmware> FLASH", 

then press the [ENTER] key on your keyboard. For details on the update file of the 
firmware, see "Updating the Firmware," on p. 5-21.

• You can obtain the default value of the network board by entering "get defaults" and 
pressing the [ENTER] key on your key board to download the list of the default 
value of the network board.

• The download directory for the config file varies depending on the operating 
system or settings. If you cannot find the config file, browse the config file using the 
file browse function of the operating system.

5 Using Notepad, etc., edit downloaded the config file.

For details on descriptions of each option, see "Network Setting Items," on p. 5-2.

6 Enter the following command, then press the [ENTER] key on 
your keyboard.

put <File Name> CONFIG

NOTE
In <File Name>, enter the name of the config file that was entered when the file 
was downloaded.

7 Enter the following command, then press the [ENTER] key on 
your keyboard to reset the network board.

get reset

After completing the reset of the network board, the settings are effective.

NOTE
The settings also become effective by restarting the printer (Turn OFF the printer 
once, wait for 10 seconds or longer, and then turn it ON).
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8 Enter "quit", then press the [ENTER] key on your keyboard.

9 Enter "exit", then press the [ENTER] key on your keyboard.

Command Prompt or MS-DOS Prompt exits.
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You can perform the basic protocol settings and display the status of the printers on 
a network using NetSpot Device Installer. This section describes the procedure for 
running or installing NetSpot Device Installer. For details on the procedures for 
using NetSpot Device Installer, see Online Help of NetSpot Device Installer.

Configurable Devices
NetSpot Device Installer allows you to initialize the network protocols of the devices 
connected to a TCP/IP network. You cannot configure the devices connected to a 
network other than the TCP/IP network using NetSpot Device Installer.

Printer

Printer
Protocol : TCP/IP

Printer

USB

USB
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Installing NetSpot Device Installer
Install NetSpot Device Installer using the following procedure.

IMPORTANT
• Close all the other applications before the installation.
• If you are using Windows NT 4.0/2000/XP/Server 2003, be sure to log on as a member of 

Administrators when starting up.
• If you are using Windows XP Service Pack 2 or another operating system equipped with 

Windows Firewall, and the Windows Firewall is enabled, you cannot search for the 
printers on a subnet that is different from the one that the computers using NetSpot 
Device Installer are on. To search for a printer on a subnet that is different from the one 
that the computer you are using is on, see Readme of NetSpot Device Installer and add 
"NetSpot Device Installer" to the [Exceptions] sheet in the [Windows Firewall] dialog box.

NOTE
• NetSpot Device Installer is utility software that you can use without installing it. When 

using NetSpot Device Installer without installing it, read "Running NetSpot Device 
Installer," on p. 3-51.

• You can expand the functions of NetSpot Device Installer by adding Plug-Ins. When using 
the functions of Plug-Ins, install both NetSpot Device Installer and Plug-Ins on the 
computer. For more details on Plug-Ins, see Readme of NetSpot Device Installer.

1 Insert the supplied CD-ROM into the CD-ROM drive.

If CD-ROM Setup appears, click [Exit].

2 Open [My Computer], then select the CD-ROM drive.
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3 Select [Open] from the [File] menu.

4 Double-click the [NetSpot_Device_Installer] folder.
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5 Double-click the [Windows] folder.

6 Double-click [nsdisetup.exe].
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7 Click [Yes].

8 Click [Browse], then select the installation directory.

If you want to add NetSpot Device Installer to the [Start] menu, select the [Add to 
Start Menu] check box.
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9 Click [OK].

Installation of NetSpot Device Installer is started.

If you are using Windows XP Service Pack 2 or another operating system 
equipped with Windows Firewall, and the Windows Firewall is enabled, the 
following screen is displayed.

If you want to register the application, click [Yes]. If you click [No], you cannot 
search for the printers in which the IP address has not been set yet or the printers 
on a subnet that is different from the one that the computer using NetSpot Device 
Installer is on.

10 The screen that informs you of the completion of the printer 
driver installation is displayed. Click [OK].
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11 Select the Plug-Ins that you want to install, then click [Start 
Installation].

For more details on Plug-Ins, see the Readme file of NetSpot Device Installer.

NOTE
You can install Plug-Ins later. For details on installing Plug-Ins later, see the 
Readme file.

The installation of NetSpot Device Installer is completed.

Running NetSpot Device Installer
This section describes the procedure for running NetSpot Device Installer.

When Running NetSpot Device Installer Installed on a Computer

1 From the [Start] menu, select [All Programs] � [NetSpot 
Device Installer] � [NetSpot Device Installer].

For Windows 98/Me/2000: From the [Start] menu, select [Programs] � [NetSpot 
Device Installer] � [NetSpot Device Installer].

NetSpot Device Installer runs.

NOTE
If you did not add NetSpot Device Installer to the [Start] menu when you installed it, 
double-click [nsdi.exe] in the folder in which NetSpot Device Installer is installed.
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When Running NetSpot Device Installer from the Supplied CD-ROM.

1 Insert the supplied CD-ROM into the CD-ROM drive.

2 Click [Additional Software Programs].

3 Click [Start] in [NetSpot Device Installer for TCP/IP].

NetSpot Device Installer runs.

How to Use NetSpot Device Installer
For more details on the procedures for using NetSpot Device Installer, see Online 
Help. Online Help is displayed by clicking [Help] in the [Help] menu.
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CHAPTER

4
Troubleshooting
This chapter describes the troubleshooting procedures for problems occurred in the network 
environment.
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Installation Problems
If the printer driver cannot be installed properly, perform the following procedure to 
check problems.

NOTE
For details on the problems on the local installation, see "User's Guide".

Uninstall the CAPT software 
with Uninstaller.
See "Uninstalling the CAPT 
Software," on p. 2-77.

Uninstall the CAPT software 
with Uninstaller.
See "Uninstalling the CAPT 
Software," on p. 2-77.

Delete this printer from [Add or 
Remove Programs] ([Add/Remove 
Programs Properties] on Windows 
98/Me; [Add/Remove Programs] on 
Windows 2000).
See "When Uninstallation Fails," 
on p. 4-3.

Install the CAPT software 
again.
See "Installing the CAPT Software 
from CD-ROM Setup," on p. 2-2. Install the CAPT software 

again.
See "Installing the Printer Driver 
Manually Using Various Utility 
Software," on p. 2-14.

Install the CAPT software 
again.
See "Installing the Printer Driver 
Manually Using Various Utility 
Software," on p. 2-14.

[Canon Printer Uninstaller] is 
displayed in [All Programs] 

([Programs] for Windows 98/Me/2000) 
from the [Start] menu.

This printer is displayed in 
[Add or Remove Programs] 

([Add/Remove Programs Properties] 
on Windows 98/Me; 

[Add/Remove Programs] 
on Windows 2000).

Yes

No No

Cannot uninstall

Cannot uninstall

Yes
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When Uninstallation Fails
If you cannot uninstall the CAPT software using the Uninstaller that was created 
during installation, use the following procedure to uninstall the CAPT software from 
[Add or Remove Programs] ([Add/Remove Programs Properties] for Windows 98/
Me; [Add/Remove Programs] for Windows 2000).

1 From the [Start] menu, select [Control Panel], and then click 
[Add or Remove Programs].

For Windows 98/Me/2000: From the [Start] menu, select [Settings] � [Control 
Panel], and then double-click [Add/Remove Programs].
For Windows Server 2003: From the [Start] menu, select [Control Panel] � [Add 
or Remove Programs].

2 Select the name of this printer in the [Add or Remove 
Programs] dialog box, then click [Change/Remove].

For Windows 2000: Select the name of this printer in the [Add/Remove Programs] 
dialog box, then click [Change/Remove].
For Windows 98/Me: Select the name of this printer in the [Add/Remove 
Programs Properties] dialog box, then click [Add/Remove].

NOTE
If the name of this printer is not displayed in the dialog box, perform "Installing the 
Printer Driver Manually Using Various Utility Software" (p. 2-14) to install the CAPT 
software again.
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3 Select the name of this printer, then click [Delete].

A confirmation message is displayed.

4 Click [Yes].

Uninstallation starts. Please wait a moment.

5 Click [Exit].

The [Delete Printer] dialog box closes.

6 Restart Windows.
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NOTE
For details on problems on the printer such as a paper jam and poor printing quality, see 
"User's Guide".

Cannot Print from the Network
 

Cause 1 The network board and cable are not connected properly.
 

Remedy Check the following points, and then cycle the power of the printer.

• Make sure that the network board is installed properly. (See User's Guide)

• Make sure that the printer is connected to the network by an appropriate 
cable. (See User's Guide)

 

Cause 2 The network is not configured properly.
 

Remedy 1 Make sure that the IP address is set properly.

NOTE
Use the following checking procedures.

1. Run Command Prompt or MS-DOS Prompt.

- For Windows XP/Server 2003: From the [Start] menu, select [All Programs] � 
[Accessories] � [Command Prompt].

- For Windows 2000: From the [Start] menu, select [Programs] � [Accessories] � 
[Command Prompt].

- For Windows Me: From the [Start] menu, select [Programs] � [Accessories] � 
[MS-DOS Prompt].

- For Windows 98: From the [Start] menu, select [Programs] � [MS-DOS Prompt].
2. Enter "ftp <the IP address of the printer>".

- Input Example :ftp 192.168.0.215

3. If the IP address is set properly, the following command is entered.
- Connected to <the IP address of the printer>

 

Remedy 2 Before setting the IP address using any one of DHCP, BOOTP, or RARP, make 
sure that the protocol is running. (See "Protocol Settings for the Printer," on p. 
2-60)
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Cause 3 Canon CAPT Print Monitor is not installed
 

Remedy When installing the printer driver from [Add Printer Wizard] or by setting the port 
manually using the CD-ROM (CD-ROM Setup) supplied with the printer, be sure 
to install Canon CAPT Print Monitor before installing the printer driver. (See 
"Installing the Printer Driver Manually Using Various Utility Software," on p. 
2-14)

 

Cause 4 The computer that performs printing is not configured properly.
 

Remedy Check the following points.

• Make sure that the printer is specified as the default printer.

• Make sure that the printer driver is installed properly. In order to check if the 
printer driver is installed properly, perform Network Status Print (See 
"Checking the Operations with Network Status Print," on p. 2-57). If you 
cannot print properly, uninstall the printer driver and install it again. (See 
"Uninstalling the CAPT Software," on p. 2-77, "Installing the CAPT Software," 
on p. 2-2)

• Make sure that the TCP/IP protocol is running.
 

Cause 5 The IP address of the computer that sends the print data is restricted in 
[Restrict TCP/IP Printing] in [IP Address Range Settings].

 

Remedy Confirm the setting of [Restrict TCP/IP Printing] in [IP Address Range Settings]. 
See "Restricting the Users Who Can Print," on p. 3-4
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Cause 6 The [Use the Unicast Communicate Mode] check box was selected when 
installing Canon CAPT Print Monitor. (The printer is in the unicast 
communication mode.)

 

Remedy When resetting to the default mode (the broadcast communication mode), 
uninstall Canon CAPT Print Monitor once, then install it again. When installing 
Canon CAPT Print Monitor, make sure that the [Use the Unicast Communicate 
Mode] check box is not selected in the following screen which is displayed when 
installing Canon CAPT Print Monitor, and then click [Next].
For details on the procedure for uninstalling Canon CAPT Print Monitor, see 
"Uninstalling Canon CAPT Print Monitor" (p. 2-79), and for details on the 
installation procedure, see "Installing the Canon CAPT Print Monitor" (p. 2-26).

IMPORTANT
When using the unicast communication mode, be sure to see "Using the Unicast 
Communication Mode," on p. 5-12 or consult your network administrator.

All the indicators on the network board are off.

Cause 1 The LAN cable is not connected properly or broken.

Remedy 1 Remove the LAN cable once, then connect it again.

Remedy 2 Replace the LAN cable with another one, then connect it.

Cause 2 The cable is connected to the UP-LINK (cascade) port on the hub.

Remedy 1 Connect the LAN cable to a port with a "X" mark.

Remedy 2 If the hub has a UP-LINK (cascade) switch, switch to "X".

Cause 3 A cross LAN cable is being used.

Remedy 1 Replace the cable with a straight LAN cable.
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Remedy 2 Connect the cross LAN cable to the UP-LINK (cascade) port on the hub. If the 
hub has a UP-LINK (cascade) switch, switch to "=".

NOTE
A cross LAN cable is a cable used to connect to a printer and computer directly.

Cause 4 Cannot communicate with the hub.

Remedy 1 Make sure that the power of the hub is on.

Remedy 2 Set the DIP switches on the netowork board according to the transmission 
speed of the connected hub. (See User's Guide)

Remedy 3 Replace the hub.

Cause 5 The network board is not installed properly.

Remedy Remove the network board once, then install it again.

Cause 6 The hardware of the network board is in an abnormal condition.

Remedy Report the problems to your local authorized Canon dealer.

The ERR indicator on the network board is on.

Cause The network cable is disconnected or broken, or the network board is not 
installed properly.

Remedy 1 Make sure the network cable is connected properly.

Remedy 2 Replace the network cable with a proper one and check if there is no 
disconnection or damage.

Remedy 3 If the ERR indicator still comes on even after applying the Remedy 1 and 2, 
contact your local Canon dealer for servicing.

The ERR indicator on the network board blinks at an interval of four times.

Cause The DIP switch 1 on the network board is on.

Remedy Set the DIP switch 1 to OFF once. (See "Initializing the Network Settings," on p. 
5-8)

The ERR indicator on the network board is keep blinking.

Cause The hardware of the network board is in an abnormal condition.

Remedy Contact your local authorized Canon dealer for servicing.
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The printer driver is provided with a function of Network Status Print that allows you 
to check the version of the network board or the TCP/IP settings. Use these 
functions when required after setting the network environment, for example when 
you want to check the operation of the network board.

NOTE
• Network Status Print is designed to be printed on A4 size paper. Load A4 size paper.
• The screen shots used in this section are from Windows XP Professional.

1 Display the [Printers and Faxes] folder or the [Printers] folder.

For Windows 98/Me/2000: From the [Start] menu, select [Settings] � [Printers].
For Windows XP Professional/Server 2003: From the [Start] menu, select [Printers 
and Faxes].
For Windows XP Home Edition: From the [Start] menu, select [Control Panel], and 
then click [Printers and Other Hardware] � [Printers and Faxes].

2 Select the icon for this printer, then select [Printing 
Preferences] from the [File] menu.

For Windows 98/Me: Select the icon for this printer, then select [Properties] from 
the [File] menu.
4-9Checking the Network Board Functions



  

Tr
ou

bl
es

ho
ot

in
g

  

4

       
3 Display the [Page Setup] sheet, then click [ ] (Display 
Printer Status Window) to run the Printer Status Window.

NOTE
For details on the Printer Status Window, see "User's Guide".

4 From the [Options] menu, select [Utility] � [Network Status 
Print].
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5 Click [OK].

Network Status Print is printed.

6 Confirm the contents of the Network Status Print.

Network Status Print prints information as shown in the following figure. You can 
check the version of the network board or the TCP/IP settings.

IMPORTANT
This is a sample of Network Status Print. The contents may differ from the Network 
Status Print printed by your computer.
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This chapter describes the network setting items in a list and the specifications of the network 
board.
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Network Setting Items
You can change the settings for the network board by using the web browser 
(Remote UI), FTP Client, or NetSpot Device Installer. The following are the setting 
items that you can change.

NOTE
• The letters shown in parentheses are exclusively for FTP Client (Example: "Device Name 

(DEVICE_NAME)" is indicated as [Device Name] in the Remote UI and NetSpot Device 
Installer, and indicated as [DEVICE_NAME] in the config file in the FTP Client).

• The asterisk marks attached to the end of some option names, such as "*1", indicate the 
following:
*1: Cannot be specified using NetSpot Device Installer. Specify these options using the Remote UI or FTP 

Client.

*2: Can be specified using FTP Client only.

� General Settings

Option Contents Default

[Print Server Name]
(PS_NAME) *1

The name of the network board (print 
server) (0 to 15 characters)

CANONX
XXXXX

[Device Name]
(SYS_NAME)

The name of the device (0 to 32 
characters)

(Blank)

[Location]
(SYS_LOC)

The installation site of the device (0 to 32 
characters)

(Blank)

[Administrator]
(SYS_CONTACT)

The name of the administrator of the 
device (0 to 32 characters)

(Blank)

[Phone]
(SYS_CONTACT_TEL) *1

The telephone number of the 
administrator of the device (0 to 32 
characters)

(Blank)

[Comments]
(SYS_CONTACT_COMMENT) *1

Comments by the administrator of the 
device (0 to 32 characters)

(Blank)

(SERVICE_MAN_NAME) *2 The name of the service person (0 to 32 
characters)

(Blank)

(SERVICE_TEL) *2 The telephone number of the service 
person (0 to 32 characters)

(Blank)

(SERVICE_COMMENT) *2 Comments by the service person (0 to 32 
characters)

(Blank)
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[Administrator Password]
(ROOT_PWD)

The password of the device (0 to 15 
characters)

(Blank)

[Display Language] 
(DISP_LANG) *1

The languages displayed in the Remote 
UI (English, French, German, Italian, 
Spanish, Japanese, Default)

Default

[Link]
(LINK_NAME1) *1

(LINK_NAME2) *1

The link displayed in the [Support Links] 
page in the Remote UI (0 to 32 
characters)

(Blank)

[URL]
(LINK_URL1) *1

(LINK_URL2) *1

The URL displayed in the [Support Links] 
page in the Remote UI (0 to 128 
characters)

(Blank)

[Comments]
(LINK_COMMENT1) *1

(LINK_COMMENT2) *1

The comments displayed in the [Support 
Links] page in the Remote UI (0 to 64 
characters)

(Blank)

[Link]
(DOWNLOAD_SITE_NAME) *1

The link displayed in the [Support Links] 
page in the Remote UI (0 to 32 
characters)

Download 
Service

[URL]
(DOWNLOAD_SITE_URL) *1

URL displayed in the [Support Links] 
page in the Remote UI/URL selected by 
clicking [Device Manager] in the Remote 
UI - the [Network] page - [Download Site] 
under [Firmware] (0 to 128 characters)

http://
www.cano
n.com/
download/

[Comment]
(DOWNLOAD_SITE_COMMENT
) *1

The comments displayed in the [Support 
Links] page in the Remote UI (0 to 64 
characters)

Update 
network 
firmware

[SNMPv1]
(SNMP_V1_ACCESS_ENB)  *1 Access using the SNMPv1 protocol YES

[Access Rights]
(SNMP_V1_ACCESS_MODE) *1

SNMPv1 agent's operation mode
(Read-Only, Read-Write)

Read and 
Write

[Community Name]
(PUB_COMMUNITY) *1

The community name of SNMP (0 to 32 
characters)

public

[SNMPv3]
(SNMP_V3_ACCESS_ENB) *1 Access using the SNMPv3 protocol NO

[Restrict TCP/IP Printing]
(TCP_CONT_ENB) *1

Whether to restrict the users who can 
print

NO

[Permit Specified Addresses]/
[Reject Specified Addresses]
(TCP_CONT_MODE) *1

Accept or reject the jobs by a user whose 
name is entered in [IP Addresses] 
(TCP_CONT_LIST) (Accept, Reject)

Accept

Option Contents Default
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[IP Addresses]
(TCP_CONT_LIST) *1

The IP addresses restricted to perform 
TCP/IP printing

(Blank)

[Restrict SNMP Monitoring/
Setting Changes]
(SNMP_CONT_ENB) *1

Whether to restrict users who can 
monitor/change the SNMP setting

NO

[Permit Specified Addresses]/
[Reject Specified Addresses]
(SNMP_CONT_MODE) *1

Accept or reject monitoring/changing the 
settings for the device using the SNMP 
protocol by a user whose name is 
entered in [IP Addresses] 
(SNMP_CONT_LIST) (Accept, Reject)

Accept

[IP Addresses]
(SNMP_CONT_LIST) *1

The IP addresses restricted to monitor/
change the SNMP setting

(Blank)

[Restrict Multicast Discovery]
(SLP_CONT_ENB) *1

Whether to restrict the users who can 
perform the multicast discovery

NO

[Respond to Specified IP 
Addresses]/
[Do Not Respond to Specified 
Addresses]
(SLP_CONT_MODE) *1

Accept or reject the searches that used 
the multicast discovery by a user whose 
name is entered in [IP Addresses] 
(SLP_CONT_LIST) (Accept, Reject)

Accept

[IP Addresses]
(SLP_CONT_LIST) *1

The IP addresses restricted to perform 
the multicast discovery

(Blank)

[Restrict MAC Address Access]
(MAC_CONT_ENB)

Whether to restrict the devices that can 
access

NO

[Permit Specified Addresses]/
[Reject Specified Addresses]
(MAC_CONT_MODE)

Accept or reject the access by a device 
whose name is entered in [MAC 
Addresses] (MAC_CONT_LIST) (Accept, 
Reject)

Accept

[MAC Addresses]
(MAC_CONT_LIST)

The MAC addresses permitted or 
rejected to access

(Blank)

[Access Logs]
(SEC_LOG_ENB) *1 Whether to obtain a security access log NO

Option Contents Default
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� TCP/IP Settings

[Log Types]
(SEC_LOG_KIND) *1

Security access logs to obtain
0: No Access Log to Obtain
1: Rejected TCP/IP Print Jobs
2: Rejected SNMP Monitoring/Setting 
Changes
3: Rejected TCP/IP Print Jobs and 
Rejected SNMP Monitoring/Setting 
Changes
4: Rejected Multicast Discoveries
5: Rejected TCP/IP Print Jobs and 
Rejected Multicast Discoveries
6: Rejected SNMP Monitoring/Setting 
Changes and Rejected Multicast 
Discoveries
7: Access All the Logs

0

Option Contents Default

[Frame Type]
(TCP_FRAME_TYPE)

The frame type being used by TCP/IP
Ethernet 
II

(G_ARP_ENB) *2 Whether to use the Gratuitous ARP 
function

YES

[DHCP]
(DHCP_ENB)

Whether to use DHCP for the IP address 
setting

NO

[BOOTP]
(BOOTP_ENB)

Whether to use BOOTP for the IP address 
setting

NO

[RARP]
(RARP_ENB)

Whether to use RARP for the IP address 
setting

NO

[IP Address]
(INT_ADDR)

The IP address of the printer
192.168.
0.215

[Subnet Mask]
(NET_MASK)

Subnet Mask 0.0.0.0

[Gateway Address]
(DEF_ROUT)

Gateway Address 0.0.0.0

[DNS Server Address]
(DNS_ADDR) *1 The IP address of the DNS server 0.0.0.0

[DNS Dynamic Update]
(DDNS_ENB) *1

Whether to register this device in DNS 
dynamically

NO

Option Contents Default
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[DNS Host Name]
(HOST_NAME) *1

The host name of this device (0 to 63 
characters)

(Blank)

[DNS Domain Name]
(DOMAIN_NAME) *1

The name of the domain to which this 
device belong (0 to 64 characters)

(Blank)

[WINS Resolution]
(WINS_ENB) *1 Whether to use WINS Resolution YES

[WINS Server Address]
(WINS_ADDR1) *1 WINS Server Address 0.0.0.0

[WINS Host Name]
(WINS_HOSTNAME) *1

Registration of the host name of WINS (0 
to 15 characters)

(Blank)

[Scope ID]
(NBT_SCOPE_ID) *1

The identifier to specify the 
communication range of the printer and 
computer (0 to 220 characters)

(Blank)

[SNTP Server Name]
(SNTP_ADDR) *1

The IP address or name of the SNTP 
server (0 to 64 characters)

(Blank)

(SNTP_CHECK_
INTERVAL) *2

The time interval for updating SNTP
(10min, 30min, 1hours, 3hours, 6hours, 
12hours, 24hours)

1hours

[Multicast Discovery Settings]
(SLP_ENB) *1

Whether to receive responses to searches 
that used the multicast discovery

YES

[Scope Name]
(SLP_SCOPE) *1

The scope name to be used in the 
multicast discovery (0 to 32 characters)

default

(USB_IP_PORT_NAME)*2 Whether to use the unicast 
communication mode

NO

[Time Zone]
(TIME_ZONE)

Time Zone
GMT
+ 0: 00

[Daylight Saving Time]
(DAYLIGHT_SAVING)

Whether to set the daylight saving time YES

Option Contents Default
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You can perform the network settings using the following software

O: Specifiable X: Not specifiable

* Some settings are specifiable (See "Network Setting Items," on p. 5-2)

Setting
Web 

Browser 
(Remote UI)

FTP Client
NetSpot 
Device 

Installer

ARP/PING 
Command

Printer 
Status 

Window

Resetting the IP 
address (See p. 
2-15, p. 2-22, p. 
2-24)

X X O O O

Protocol settings
(See p. 2-60)

O O O* X X

Restricting the users 
who can print (See p. 
3-4, p. 3-42)

O O X X X

Restricting the users 
who can monitor/
change the settings 
using the SNMP 
protocol (See p. 
3-10, p. 3-42)

O O X X X

Restricting the users 
who can use the 
multicast discovery
(See p. 3-18, p. 3-42)

O O X X X

Restricting MAC 
address access
(See p. 3-23)

O O X X X

Obtaining a security 
access log
(See p. 3-29, p. 3-42)

O O X X X
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Initializing the Network Settings
If you want to reset the network board to the default values, use any method from 
among Remote UI, FTP Client, and NetSpot Device Installer.

• Remote UI: See "Initializing the Network Settings," on p. 3-37.

• FTP Client: See "Managing the Printer Using FTP Client," on p. 
3-42.

• NetSpot Device Installer: 1. Select the name of the printer that you want to 
reset, and then select [Restore to Default Settings] 
from the [Device] menu.

2. If a message appears, click [Yes].

3. If the message<The Device has been reset.> is 
displayed, the settings are effective after clicking 
[OK] to complete resetting of the network board. If 
the message <Turn the device off and then on 
again.> is displayed, the settings are effective 
after clicking [OK] and cycling the power of the 
printer.

Even if none of the above procedures work, you can reset the settings for the 
network board by manipulating the DIP switches using the following procedure. A 
Phillips screwdriver is required to reset the settings for the network board. Have a 
screwdriver ready in advance that matches the size of the screws.

IMPORTANT
• Make sure that the printer is not operating before initializing the network settings. If you 

initialize the print server while the printer is printing or receiving data, the received data 
may not be printed properly, or may result in paper jams or damage to the printer.

• If you are using Windows XP Service Pack 2 or another operating system equipped with 
Windows Firewall and the Windows Firewall is enabled, and when you reset the network 
board to the default settings using NetSpot Device Installer, observe the following. 
When Windows Firewall is enabled, you cannot search for the printers on a subnet that is 
different from the one that the computers using NetSpot Device Installer are on. To 
search for a printer on a subnet that is different from the one that the computer you are 
using is on, see Readme of NetSpot Device Installer and add "NetSpot Device Installer" 
to the [Exceptions] sheet in the [Windows Firewall] dialog box.

• The procedures for removing or installing the network board in this manual may be 
different from those for the printer you are using. For more details on the procedures for 
removing or installing the network board, see "User's Guide".
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1 Press " " of the power switch to turn the printer OFF, remove 
the USB cable, and then disconnect the power plug from the 
AC power outlet.

2 Remove all the interface cables and the power cord from the 
printer.

3 Remove the two screws and remove the network board.

NOTE
Do not touch the network board parts, printed wire, or connectors with your hands.

4 Switch the DIP switch 1 (A) to ON.

Set the DIP switches with the tip of a ball-point pen etc.

IMPORTANT
When setting the DIP switches, be careful not to damage the main board with the 
tip of a ball-point pen etc. Do not use a sharp object such as a mechanical pencil.

5 Insert the network board into the expansion slot.

Hold the metal panel portions of the network board and insert the board while 
aligning it with the guide rails inside the expansion slot.

IMPORTANT
• Do not touch the network board parts, printed wire, or connectors with your hands.
• Insert the printer connector of the network board securely into the connector inside 

the expansion slot.

ERR LNK 100

NB-C1

ON
OFF

1 2 3 4

(A)
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6 Secure the top and bottom portions of the network board with 
the two screws supplied with the network board.

7 Connect the power cord.

8 Plug the power plug into the AC power outlet.

9 Press " " of the power switch to turn the printer ON, wait until 
the Ready indicator comes on, and then press " " of the 
power switch to turn the printer OFF.

10 Disconnect the power plug from the AC power outlet.

11 Remove the power cord.

12 Remove the network board, then reset the DIP switch 1 (A) to 
OFF.

Set the DIP switches with the tip of a ball-point pen etc.

IMPORTANT
When setting the DIP switches, be careful not to damage the main board with the 
tip of a ball-point pen etc. Do not use a sharp object such as a mechanical pencil.

ERR LNK 100

NB-C1

OFF
OFF

1 2 3 4

(A)
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13 Install the network board.

14 Connect the interface cables except for the USB cable, and 
connect the power cord.

15 Plug the power plug into the AC power outlet.

16 Connect the USB cable as needed.
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Using the Unicast Communication Mode
Unicast Communication Mode
The unicast communication mode does not perform broadcast operation that is 
normally performed by the broadcast communication mode. Therefore, there are 
the following major differences between when using the unicast communication 
mode and when using the broadcast communication mode.

*1 Only when the printer and computer you are using are on the same subnet

*2 Do not obtain the IP address using the DHCP server

To use the unicast communication mode, the following settings are required.

� Setting a Computer to Enter into the Unicast Communication Mode (See p. 
5-13)
Install Canon CAPT Print Monitor and the printer driver (perform the port setting) to use 
the unicast communication mode.

� Setting the Network Board to Enter into the Unicast Communication Mode 
(See p. 5-18)
Using FTP Client, download the config file, and then change the settings for the network 
board to enter into the unicast communication mode.

Unicast Communication 
Mode

Broadcast Communication Mode

When installing the 
printer driver (When 
creating a port)

The printer and computer are 
not required to be connected 
each other via a network

The printer and computer are 
required to be connected each 
other via a network, and the printer 
needs to be ON

When the IP 
address of the 
printer is changed

The IP address is required to 
be set on the computer

The IP address is not required to 
be set on the computer because it 
is detected automatically *1

When the network 
board is replaced

Only the network board is 
required to be configured (the 
IP address setting and unicast 
communication mode)

The network board requires the IP 
address setting, and the computer 
requires reinstallation of the printer 
driver (the port setting)

DHCP operation Disabled* 2 Enabled
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IMPORTANT
When using the unicast communication mode, be sure to consult your network 
administrator.

NOTE
If the message <Network Board Error> is displayed in the Printer Status Window after 
setting the unicast communication mode, click the [Refresh] button in the Printer Status 
Window.

Setting a Computer to Enter into the Unicast 
Communication Mode

Installing Canon CAPT Print Monitor

1 Insert the supplied CD-ROM into the CD-ROM drive.

If CD-ROM Setup appears, click [Exit].

2 Open [My Computer], then select the CD-ROM drive.

3 Select [Open] from the [File] menu.

4 Double-click the [Print_Monitor_Installer] folder.

5 Double-click the [English] folder.

6 Double-click [Setup.exe].

The installer of Canon CAPT Print Monitor starts.

7 Click [Next].

The [License Agreement] dialog box is displayed.
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8 Confirm the contents and select [I accept the terms in the 
license agreement], and then click [Next].

9 Select the [Use the Unicast Communicate Mode] check box, 
then click [Next].

10 Click [Start].

Installation of the Canon CAPT Print Monitor starts.

11 Click [Exit].

Installing the Printer Driver

1 Insert the supplied CD-ROM into the CD-ROM drive.

If the CD-ROM is already in the drive, eject the disk and re-insert it into the drive.

IMPORTANT
If CD-ROM Setup does not appear, select [Run] from the [Start] menu, enter 
"D:\English\MInst.exe", and then click [OK]. (The CD-ROM drive name is indicated 
as "D:" in this manual. The CD-ROM drive name may differ depending on the 
computer you are using.)
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2 Click [Easy Installation] or [Custom Installation].

3 Click [Install].

4 Click [Next].

The [License Agreement] dialog box is displayed.

5 Confirm the contents and select [I accept the terms in the 
license agreement], and then click [Next].

6 Select [Manually Set Port to Install], then click [Next].

7 Click [Next].

NOTE
Do not select the [Install Printer Driver through a USB Connection] check box.

8 Select [Add Port] for [Port Settings], then click [Settings].
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9 Select [Canon CAPT Port], then click [OK].

10 Enter the IP address of the network board (print server) in [IP 
Address].

11 Click in the entry field for [Name].

The port name is automatically entered in [Name] according to the IP address.

IMPORTANT
The IP address and the port name must match the settings of the network board 
(print server). For details on the settings for the network board (print server), see 
"Setting the Network Board to Enter into the Unicast Communication Mode" (p. 
5-18), or ask your network administrator.

12 Click [OK].
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13 Select whether or not to use this printer as the default printer, 
then click [Next].

14 Click [Start].

15 The message <Installation cannot be stopped once it starts. 
Do you want to continue?> appears. Click [Yes].

Installation of the printer driver starts.

16 Click [Exit].

17 If [Easy Installation] is selected in Step 2, the manuals are 
installed.

18 Confirm the installation results, then click [Next].

19 Select the [Restart Computer Now (Recommended)] check 
box, then click [Restart].
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Setting the Network Board to Enter into the Unicast 
Communication Mode

1 Run Command Prompt or MS-DOS Prompt.

For Windows XP/Server 2003: From the [Start] menu, select [All Programs] � 
[Accessories] � [Command Prompt].
For Windows 2000: From the [Start] menu, select [Programs] � [Accessories] � 
[Command Prompt].
For Windows Me: From the [Start] menu, select [Programs] � [Accessories] � 
[MS-DOS Prompt].
For Windows 98: From the [Start] menu, select [Programs] � [MS-DOS Prompt].

2 Enter the following command, then press the [ENTER] key on 
your keyboard.

ftp <the IP address of the printer>

3 Enter "root" as the user name, then press the [ENTER] key on 
your keyboard.

� If the password is specified for the printer

❑ Enter the password.

� If the password is not specified for the printer

❑ Do not enter the password, but press the [ENTER] key on your keyboard.

4 Enter the following command, then press the [ENTER] key on 
your keyboard.

get config <File Name>

The config file is downloaded. The letters entered for <File Name> become the 
name of the downloaded config file.

IMPORTANT
For Windows 98/Me, do not enter "config" for <File Name>.

NOTE
The download directory for the config file varies depending on the operating 
system or settings. If you cannot find the config file, browse the config file using the 
file browse function of the operating system.
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5 Open the config file downloaded by Notepad, etc.

6 Edit "PS_NAME" to the port name of the computer (the port 
name specified in Step 11 (See p. 5-16) of "Installing the 
Printer Driver")

Input Example : PS_NAME. :192_168_0_215

IMPORTANT
Be sure to match "PS_NAME" in the config file with the port name of the computer.

7 Edit "YES" to "USE_IP_PORT_NAME".

Input Example : USE_IP_PORT_NAME. :YES

8 Save the config file.

9 Enter the following command, then press the [ENTER] key on 
your keyboard.

put <File Name> CONFIG

NOTE
In <File Name>, enter the name of the config file that was entered when the file 
was downloaded.

10 Enter the following command, then press the [ENTER] key on 
your keyboard to reset the network board.

get reset

After completing the reset of the network board, the settings are effective.

NOTE
The settings also become effective by restarting the printer (Turn OFF the printer 
once, wait for 10 seconds or longer, and then turn it ON).

11 Enter "quit", then press the [ENTER] key on your keyboard.

12 Enter "exit", then press the [ENTER] key on your keyboard.

Command Prompt or MS-DOS Prompt exits.
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NOTE
If the message <Network Board Error> is displayed in the Printer Status Window 
after setting the unicast communication mode, click the [Refresh] button in the 
Printer Status Window.
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Select the update file, then update the firmware of the print server.

IMPORTANT
• When you cannot update the firmware properly or want to know details on the procedure 

for updating the firmware, see the README file supplied with the firmware.
• Make sure that the printer is not operating before updating the firmware. Do not print 

during the firmware update. Otherwise, the firmware cannot be updated properly.

1 Run the web browser, enter the following URL in [Location] or 
[Address], and then press the [ENTER] key on your keyboard.

http://<the IP address or name of the printer>/

Input Example : http://192.168.0.215/

2 Click [Log In].
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NOTE
If a password is specified for the printer, enter the password, and then click [Log In]. 
If the password has not been specified yet, it is not required to enter the password.

3 Click [Network] from the [Device Manager] menu.
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4 Confirm the current version of the firmware in [Version], then 
click [Update Firmware].
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5 Click [Browse], then select the update file for the firmware or 
enter the path.
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6 Click [Update] to update the firmware.

IMPORTANT
When you cannot update the firmware properly, see the README file supplied with 
the firmware.
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Specifications
Hardware Specifications

Software Specifications

CPU RISC 100MHz

ROM 2MB (flash ROM)

RAM 8MB

Network Interface
10BASE-T/100BASE-TX (RJ-45)
Full duplex; Half duplex

Indicators 3 pieces (ERR, LNK, 100)

Compatible Protocols TCP/IP

TCP/IP Frame Type: Ethernet II

Printing Software CAPT (Canon Advanced Printing Technology)
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